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1 

DDOOII  LLEEAARRNN  OOVVEERRVVIIEEWW  

DOI LEARN is a state-of-the-art e-learning management and delivery system. This site is 
designed as a virtual building that hosts a variety of learning and development services. 
DOI LEARN includes several learning functions, such as online courses, instructor led 
courses, testing, and reporting.  

Navigating DOI LEARN 

A user can navigate in the site a number of different ways: 

Quick Link Menu Bar 

This navigation is located in the top right of each screen. These links allow one-click 
access to a number of frequently accessed pages.  

• Log Off - correct way to log out of the site 

• My Courses - All Training page specifying the user's assigned training 

• Catalog - course catalog to search and locate courses 

• Enable Text-Only - 508 compliant link 

• ? - context-sensitive eHelp document 

Navigation Bar 

The navigation bar includes a main menu bar and a sub-menu bar. The sub-menu tabs 
will navigate to other features in the site. Depending on the options available, there may 
be an additional row of tabs for expanded functionality. 
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Permissions 

There are various permission levels (also known as privileges) in DOI LEARN. They 
determine which Learning Center options are available to you. The system determines 
your permission-level based on the log in you use to access DOI LEARN. 

 

Permission Level Description 

Supervisor A student can be designated as a Supervisor, which enables 
them to access information about other students who have been 
designated as being on that student-supervisor's team. 

This process will generate a new password and send it to the user by email. The user will 
have one day to log in before the password expires. 

To Request a New Password 

1. On the login page, click the I forgot my password link. 

2. In the User Name text box, type your User Name. If you have forgotten your 
assigned user name, notify an administrator. 

3. Click the Send Password button. An email will be sent to the email address in 
this specific user's profile. 
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AAPPPPRROOVVAALL  QQUUEEUUEE  

The Department Head, Instructors and Supervisors have the ability to review, approve, or 
deny student course enrollments using the approval queue. When a Student requests 
training the request will appear in the approval queue and the Supervisor will receive an 
email stating the student requested training. The Supervisor will then approve or deny 
that request using the approval queue. The Department Head and the Instructors also have 
the ability to approve or deny training requests but they will not receive email notification 
of a request. 

Navigating to the Approval Queue 

1. Click the Course Catalog tab. 

2. Click the Approval Queue sub-tab or link. 

Maintaining Denial Reasons 

Denial reasons allow the Department Head, the Instructors and the Supervisors to set 
custom reasons for denying a registration request. The custom denial reasons are 
displayed in the Action column of the Approval Queue list and in the Action Taken field 
of the Request Registration Detail.  

To Add a Denial Reason 

1. Navigate to the Approval Queue. 

2. Click the Edit Denial Reasons link. 

3. In the Name text box, type the reason. 

4. In the Description text box, type a brief description. 

5. Click the Save button. 
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To Edit a Denial Reason 

1. Navigate to the Approval Queue. 

2. Click the Edit Denial Reasons link. 

3. From the Edit drop-down, select the reason to edit. 

4. Click the Edit button. 

5. Update the information. 

6. Click the Save button. 

To Delete a Denial Reason 

1. Navigate to the Approval Queue. 

2. Click the Edit Denial Reasons link. 

3. From the Edit drop-down, select the reason to delete. 

4. Click the Edit button. 

5. Click the Delete button.  

Note: If there are requests currently using the drop reason, it will not be 
deleted. 

Taking Action on a Course Enrollment 

To Take Action on a Course Enrollment 

1. Navigate to the Approval Queue. 

2. Locate the course enrollment in the list. If necessary, filter for the desired view: 

a. From the View drop-down, select the desired approval status. 

b. Click the Go button. 

3. In the Action column, click the Awaiting Approval link for the selected course. 
You can only change enrollments with the Awaiting Approval action. 

4. From the Action Taken drop-down, select the desired action. 

5. In the Responder Comments text box, type the desired comment. 

6. Select the Payment Method from the drop-down box. Click Go. 

7. Fill out the required fields of the payment Information section.  

8. Click the Submit button. 
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To Email a Student 

1. Navigate to the Approval Queue. 

2. To sort the list alphabetically by last name, click the User column heading link. 

3. Locate the desired student. 

4. To launch a new email document in your email program, click the email address 
link. 

To View a Responder's Comments 

1. Navigate to the Approval Queue. 

2. Locate the desired student. 

3. In the Action column, click the approval status link. 

4. Click the Close link when finished. 
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BBUULLLLEETTIINN  BBOOAARRDD  ((MMOOVVEE  TTOO  EENNDD  WWIITTHH  CCHHAATT  
RROOOOMM))  

DOI LEARN's Bulletin Board provides users the opportunity to communicate with one 
another in the form of “threaded discussions.” The Bulletin Board provides multiple 
subject forums within which users may post questions, comments and ideas publicly that 
can be accessed by others interested in a particular topic or discussion. Files may also be 
attached to posts. Because a record of these discussions is maintained, their content 
becomes searchable. 

The Department Head maintains the bulletin board at the forum level. When a forum is 
created, Moderators are assigned. Moderator privileges include the ability to edit and 
delete posts that may be incorrect or inappropriate. All users may create new topics and 
new postings within those topics.  

Navigating to the Bulletin Board 

To Access the Bulletin Board 

1. Click the Communication tab. 

2. Click the Bulletin Board sub-tab or link. 

Searching for Topics 

One feature of the Bulletin Board is a Search capability. This allows the user to search by 
a keyword. The search will research any topic or post relating to that keyword, thus 
enabling users to find information very quickly. 

1. Navigate to the Bulletin Board. 

2. In the Search text box, type the desired keyword. 

3. Click the Search button. 

Adding New Topics 

Users can create new topics in the Bulletin Board. These topics will lead the discussion 
thread that is created by users replying to the messages within the topic. A topic cannot 
be deleted; maintenance of the content will be handled at the forum or post level.  

1. Navigate to the desired forum in the Bulletin Board. 
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2. Locate the Forum in which to add the new topic. 

3. Click the Forum name link. 
   

 
4. Click the New Topic link. 

    

 
5. In the Title text box, type the name of the new topic. 

6. In the Message text box, type the first post of this discussion thread. 

7. Attach a file to the post. 

a. Click the Browse button. 

b. Locate the file. 

c. Click the Open button. 

8. Preview the post prior to saving. 

a. Click the Preview button. 

b. Review the content. 
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c. Click the Close button to return to the Add Topic window. 
 

 
9. Click the Save Topic button to save the topic and post it to the forum. The topic 

will display on the Bulletin Board under the selected forum. 

Locking and Unlocking a Topic 

The Department Head and the Moderators have the option to "lock" a topic that displays 
on the Bulletin Board. If a topic is locked, it will prevent users from replying to the topic 
or making any changes to the tread. This is analogous to a read only window.  

To Lock a Topic 

1. Navigate to the Bulletin Board. 

2. Locate the Forum that includes the Topic to lock, click the Forum name link. 

3. Locate the Topic to lock, click the Topic name link. 

4. Click the Lock this topic link located at the bottom of the list of posts. 
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To Unlock a Topic 

1. Navigate to the Bulletin Board. 

2. Locate the Forum that includes the Topic to lock, click the Forum name link. 

3. Locate the Topic to lock, click the Topic name link. 

4. Click the Unlock this topic link at the bottom of the list of posts. 
 

 

Replying to a Message  

Users can reply to topics and posts that have been contributed to a forum on the Bulletin 
Board. Users may also preview their replies before posting, and even attach files that 
others may access within the forum.  

1. Navigate to the Bulletin Board. 

2. Locate the Forum that includes the topic, click the Forum name link. 

3. Locate the desired Topic, click the Topic name link. 

4. Click the Reply link at the end of the post. 
    

 
  

Note:  A Reply screen appears inside a separate window. It includes the 
original message to which you are contributing your reply or comment. 
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5. In the Message text box, at the end of the original comment, type the reply. 
      

 
6. Attach a file to the post. 

a. Click the Browse button. 

b. Locate the file. 

c. Click the Open button. 

7. Preview the post prior to saving. 

a. Click the Preview button. 

b. Review the content. 

c. Click the Close button to return to the Add Topic window. 

8. Click the Save Reply button to save the reply to the Bulletin Board. 
  

Note:  The reply will display as part of a threaded discussion under the 
topic that was selected. 

 

Editing a Message 

The Department Head and the Moderators have the ability to edit a post. This may be 
done if a post appears to be off-topic, or pertain to an inappropriate subject matter, is 
clearly inaccurate or outdated, or is not edited properly.  

1. Navigate to the Bulletin Board. 

2. Locate the Forum containing the discussion content to edit, click the Forum name 
link. 

3. Locate the Topic containing the discussion content to edit, click the Topic name 
link. 
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4. Click the Edit link under the post to modify. An Edit screen appears inside a new 
window.  
    

 
5. Make the necessary modifications to the post. 

6. Click the Save Topic button. 

Tip:  If you have not done so already, consider presenting information on 
your Bulletin Board about how the various forums you have created 
should be used. This information would cover the appropriate rules and 
regulations that might apply.   

Deleting a Message 

The Department Head and the Moderators have the ability to delete a post. This may be 
done if a post appears to be off-topic, or pertain to an inappropriate subject matter, or 
even if it states clearly inaccurate or outdated information.  

1. Navigate to the Bulletin Board. 

2. Locate the Forum containing the discussion content to delete, click the Forum 
name link. 

3. Locate the Topic containing the discussion content to delete, click the Topic name 
link. 

4. Click the Delete link under the post to modify.  
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5. A dialog will appear verifying the deletion, click the Delete button. 
   

 
6. A second dialog will appear verifying the deletion, click the OK button. 
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CCHHAATT  RROOOOMM  ((MMOOVVEE  TTOO  EENNDD))  

DOI LEARN Chat Room provides users the opportunity to share instant messages with 
each other publicly or in a private chat room. In addition to text discussions, the Chat 
Room accommodates users who want to attach files and make them immediately 
available to others. Information entered through the Chat Room cannot be saved, so it is 
necessary for anyone who wants to save a correspondence to highlight the text, then copy 
and save it to another file format such as Microsoft Word or Notepad. In addition, it is 
necessary to properly log out of the Chat Room by selecting the Exit button. 

Navigating to the Chat Room 

1. Click the Communication. 

2. Click the Launch Chat Room sub-tab. 

Note: If you have installed a pop-up blocker, the chat room may not 
launch. Simple enable pop-ups for this site and you should be able to 
access the chat room. 

Sending an Instant Message from the Chat Room 

1. Navigate to the Chat Room. 

Note: Other individuals who have currently entered the Chat Room will 
appear in the upper right corner of the window. 

 
2. In the Message text box located in the lower left corner of the Chat Room 

window, type the desired message. The text box does support HTML code. 
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3. Press [Enter] on the keyboard. The message will appear above the message field. 
As others reply, their login name and message will also appear. 
   

 
4. Click the Exit button to shut down the Chat Room properly. 

Exploring Other Features inside the Chat Room 

The Chat Room provides other features that you may find useful during a chat. 

For example, there may come a time when you want to step away from a chat without 
exiting your Chat Room window. This way others will realize you are away and will not 
needlessly direct correspondence to you during a chat session. In addition, by stepping 
away without shutting down the chat session, you can preserve the display of 
correspondence that may be occurring among others. 

 

To achieve this... Do this... 

To step away from a chat 
while keeping the session 
open 

From the second drop-down directly above the Chat 
Room buttons, select Away. 

Note:  The username of any Chat Room 
participant who selects Away will appear 
with a line running through it. 
Additionally, the discussion text will 
display that the individual is away. 

To return to a chat after 
being away 

From the second drop-down directly above the Chat 
Room buttons, select Here. 

Note:  The logon name, which 
previously had a line running through it, 
will now appear without the line. In 
addition, the discussion text will display 
that the individual is back. 
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To pause the scrolling of 
messages 

1. Click the Pause button. A dialog will appear 
indicating that the scrolling of messages has been 
paused. 

2. Click the OK button. 

Note: While a chat is occurring, the 
discussion automatically scrolls down 
the page. However, there may come a 
time when you may want to step away. 
By selecting the Pause button, you may 
prevent the page from scrolling. This 
way you can come back and select 
Resume to read the entire discussion 
from where you left off. 

To resume the scrolling of 
messages after a pause 

1. Click the Resume button. A dialog will appear that 
says, "Playing," which indicates that the scrolling 
will resume. 

2. Click the OK button. 

To refresh the chat room if 
you encounter problems 

Click the Reload button. 

To use the quick chime 
feature 

Click the Quick Chime list box button and select an 
appropriate expression during the chat. 

To allow the entered text 
to remain on one line 

If it is not already selected, select the Reg option. 

To enable the entered text 
to wrap onto multiple lines 

If it is not already selected, select the Adv option. 

Note: The text field changes shape to 
accommodate a scroll bar and a Send 
button. The quick chime and status 
features will not be available. 
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Selecting between Public and Private Chats in the Chat Room 

The Chat Room not only accommodates a public chat where everyone who enters the 
Chat Room can participate, but it also accommodates a private chat where individuals 
may be invited into a private chat room for discussions strictly among themselves.  

1. Navigate to the Chat Room. 

2. Send a message either privately (See Sending a Private Message or File from the 
Chat Room) or openly (See Sending an Instant Message from the Chat Room) to 
other Chat Room participants requesting that they join the Private Chat Room. 

3. From the Rooms drop-down, select Private Chat. 

Note:  The numbers that display on the left side of the room indicate the 
room number. The number on the right indicates how many are currently 
in that particular room. A drop-down box will appear whereby you can 
lock or unlock the private chat room by making it Public or Private. 

4. Verify all participants have joined, from the second drop-down, select Private. 

 

 
 

5. Click the Exit button to shut down the Chat Room properly. 

Sending Private Information in the Chat Room 

A participant in the Chat Room has the ability to send a message or file to another 
participant that is marked private; therefore, only that selected participant will see it. A 
separate window opens where you can enter private messages targeted toward the 
individual you previously selected. Although you may also attach a file, you cannot enter 
a message and file simultaneously.   
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To Enter a Private Message 

1. Navigate to the Chat Room. 

2. Click the username of the recipient. 

3. Select the Message option. 

4. In the Message text box, type the message. 

5. Click the Send button. 

 

Note:  Your private message will appear only to the individual to whom it 
was directed. When a Chat Room participant sends you a private message, 
the text will appear in bold preceded by the text "Private message from..." 

 

To Send a File Marked Private 

1. If you have not done so already, select the recipient of the file. 

2. Select the File option. 

Note:  It is not possible to send a file and a message simultaneously. 
Therefore, the Message field will not be available after the File option has 
been selected. 
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3. Click the Browse button. 

4. Select the file to attach, click the Open button. 

5. In the Save As text box, type the file name as it will appear on the server. 

• The file extension must be included in the file name. e.g. filename.doc if it 
is a Word document or filename.jpg if it is a graphic. 
 

 
6. Click the Send button. A message from the sender privately appears to its 

recipient. A hyperlink that displays in the message provides the recipient with the 
ability to retrieve the file. 
 

 
7. Click the Exit button to shut down the Chat Room properly. 
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CCOOUURRSSEE  CCAATTAALLOOGG  ((MMOOVVEE  AABBOOVVEE  BBUULLLLEETTIINN  
BBOOAARRDD  AANNDD  CCHHAATT  RROOOOMM  ––  BBEELLOOWW  AAPPPPRROOVVAALL  
QQUUEEUUEE))  

The Course Catalog allows all users to view the available courses in DOI LEARN. These 
courses can be located by either browsing through categories or searching using 
keywords and filters. Once a course has been located a user can view certain details of 
the course such as a description, the vendor, dates and times of class sessions being 
offered, the instructor, a roster (if available), ratings and comments from other students, 
and any required prerequisites. 

Navigating to the Course Catalog 

1. Click the Registration tab. 

2. Click the Catalog sub-tab. 

Viewing Featured Courses 

1. Navigate to the Course Catalog. 

2. The courses listed on the default page of the catalog are the featured courses.  

• If there are multiple pages of featured courses, click the Next link. 

3. Click a course title to view the details and reviews. 

Searching the Course Catalog 

To Conduct a Simple Search 

1. Navigate to the Course Catalog. 

2. In the Keyword text box, type the word to search. 

• This search will match the keyword to the Course Name, Vendor Name 
and Description. 

3. Select one of the following: 

a. My Catalog: will search only the courses for which the user can self-
register. 

b. Entire Catalog: will search all of the courses in the catalog. 
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4. Click the Search button. 

 

To Conduct an Advanced Search 

1. Navigate to the Course Catalog. 

2. Click the Advanced Search link. 

3. Keyword: type the word or phrase to search. 

• This search will match the keyword to the Course Name, Vendor Name 
and Description. 

4. Occurrence in: select a specific field to search in relation to the keyword. 

5. Type of Course: SF-182 Requested, Instructor Led, Online or All. 

6. If Instructor-led, then narrow the search by selecting any combination of the 
following: 

a. Location: specify a location where the course is offered. 

b. Instructor: specify the instructor of the class. 

c. Bureau: search by the bureau that offers the class.  
d. Vendor: specify the vendor associated with the class. 

e. Date Range: select 30 days, 60 days, 90 days, or All Days. 

7. Sort: select either By Popularity or Alphabetically by Course Name. 

8. Search in:  

a. My Catalog: will search only the courses for which you can self-register. 

b. Entire Catalog: will search all of the courses in the catalog. 

9. Click the Search button. 

 
A list of courses matching the search criteria displays. If no courses meet the criteria, 
redefine the search. Click a course title to view course details and student ratings. 
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Browsing the Course Catalog 

1. Navigate to the Course Catalog. 

2. Click the Browse Catalog link. 
 

 
3. Click the course category. The available courses display. If the category you 

selected has subcategories, you may have to select a subcategory to get the 
available courses to display. 

Taking a Search & Select Course 

1. Navigate to the Course Catalog. 

2. Select the NETg Search & Select tab. 

3. Click the NETg Search & Select link. A new browser window opens. 

4. Click the Search & Select link. 

Viewing Course Details 

1. Navigate to the Course Catalog. 

2. Locate the course to register. 

a. View the Featured Courses (current page). 

b. Search the catalog. 

c. Browse the catalog. 

3. Click the course title to view the details and reviews. 

4. If available, to compare this instructor-led class time with your current schedule, 
click the Preview Schedule button. 

5. If available, to view a roster for an instructor-led class, click the View Roster 
button. 
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Registering for a Course 

1. View the class details. 

2. If there is more than one class available, locate a specific class. 

3. To register for an online course. 

• Click the Apply button. You will be returned to the Search page. 

• In the Comments text box, type the reason you are requesting this course, 
Click the Request Registration From Your Supervisor button. 

• If the message appears stating "You are already registered for this course." 
the system will not allow you to register again. 

4. To register for an instructor led course. 

a. View the details of the course you wish to register for.  

b. Click the Apply button. This creates a request awaiting approval.  

Note: If there is a conflict and you want to drop a class in order to 
register for this new class. Register for the new class first, then drop 
the desired class. 
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EEVVEENNTT  CCAALLEENNDDAARR  

DOI LEARN includes a calendar that is used to observe and record events. The 
Department Head and the Instructors can add and manage events within the calendar. 
Supervisors and Students may be assigned as Posters by the Department Head. A Poster 
can also add and manage events within the calendar. The one limitation of a Poster is 
they can only manage the events they have created. 

All users have common access to the calendar, and therefore it is not designed with 
specific audiences or individuals in mind. Nor can individuals tailor the calendar for their 
own specific needs. Consequently, most of the events that display on the Event Calendar 
represent general organization-wide announcements such as vacation days, special 
events, but most of all, any meetings that pertain to e-learning or the e-learning site in 
general. The Event Calendar provides users with five different views: a daily view, 
weekly view, monthly view, quarterly view and yearly view. 

Navigating to the Event Calendar 

1. Click the Communication tab. 

2. Click Event Calendar. 

Locating an Event  

1. Navigate to the Event Calendar. 

2. To view an event for a particular day, do one of the following: 

a. If the Jump to Today or Week View link is selected, the current view is 
the day view. 

b. If the Month View is selected, click the Event link on the day the event is 
scheduled. 

c. If the Quarter or Year View is selected, click the E link on the day the 
event is scheduled. 
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3. Within each view, a user can navigate to the previous and next periods by clicking 

the Previous and Next buttons. Click on a specific period's E or Event link for 
detailed information on that day's posted events. 

Adding an Event  

The Department Head, the Instructors, and the Posters have the ability to add events to 
the Event Calendar. 

1. Navigate to the Event Calendar. 

2. Locate the day the event will be scheduled. 

3. In the Day View of the calendar, click the hour the event is to begin. 
 

 
4. In the Add Event screen, complete the following information: 

a. In the Title text box, type the event's title.  

b. In the Description text box, type the details of the event.   

c. In the Location text box, indicate where the event is taking place.   

Tip:  For locations that are off-site, you might consider including 
inside the Location field a link to a MapQuest.com map as well as 
other directions. 

d. In the Start Date text box, confirm the event date. 
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e. Indicate whether it is an all-day event or not by checking or not checking 
the All Day Event option. 
 

 
f. Under Start Time, select the Hour, Minute and AM/PM that the event 

will begin. 

g. Under End Time, select the Hour, Minute and AM/PM that the event 
will begin. 

h. In the End Date text box, confirm the event date. 

i. If this is the only occurrence of this event, click the Save New Event 
button; otherwise, continue with step 4. 
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5. To set a daily event recurrence, complete the following information: 

a. From the Recurrence option group, select Daily. 

b. From the Recurrence Type drop-down, select whether the recurrence is 
One day (Calendar Date), Every day (Sun-Mon) or Every weekday 
(Mon-Fri). 
 

 
6. To set a weekly event recurrence, complete the following information: 

a. From the Recurrence option group, select Weekly. 

b. In the Recur every __ week(s) text box, type the number of weeks 
between each occurrence of the event. 

c. In the weekday check boxes, select the date(s) the event will occur. 
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7. To set a monthly event recurrence, complete the following information: 

a. From the Recurrence option group, select Monthly. 

b. If the event is to occur on a specific date of the month: In the Day text 
box, type the number of days into the month that you want the event to 
recur. e.g. type 5, if the event will occur on the 5th of each month. In the 
Months text box, type in the number of months apart that each occurrence 
of the event will recur. 

c. If the event is to occur on a specific day of the week within a month: From 
the drop-down, select among the list: First, Second, Third, Fourth, or 
Last. From the next drop-down, select the specific day the event is to 
recur. In the Months text box, type in the number of months apart that 
each occurrence of the event will recur. 

8. Click the Save New Event button. The event will now appear in the calendar. 

 

Editing an Event  

The Department Head and the Instructors have the ability to edit all entries in the Event 
Calendar. The Posters can edit only the events they have created. In order to locate a 
specific event to edit, it is best to know the date the event is scheduled. 

1. Navigate to the Event Calendar. 

2. Locate the day the event will be scheduled. 

3. In the Day View of the calendar, click the event name. 
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4. Click the Edit Event button. 
 

 
5. Update the information. Refer to Adding an Event for field information. 

6. Click the Update Event button. 

Deleting an Event 

The Department Head and the Instructors have the ability to delete all entries in the Event 
Calendar. The Posters can delete only the events they have created. In order to locate a 
specific event to delete, it is best to know the date the event is scheduled. 

1. Navigate to the Event Calendar. 

2. Locate the day the event will be scheduled. 

3. In the Day View of the calendar, click the event name. 

4. Click the Delete Event button. 

Note: The Calendar window reappears, however, this time the selected 
event will be removed. 

Sending an Email Regarding an Event on the Calendar 

The Event Calendar provides users the option to send an email indicating information in 
the Event Calendar.  

1. Navigate to the Event Calendar. 

2. Locate the day the event will be scheduled. 

3. In the Day View of the calendar, click the event name. 
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4. Click the Email this event link inside the daily Event Calendar. 

 
5. In the To: text box, type the email address(es). 

6. In the Cc: or Bcc: text boxes, type the email address(es). 

7. Click the Send button to complete this task; otherwise, click the Cancel button to 
return to the calendar. 
 

 
8. A dialog will appear verifying the email was sent, click the Close button. 
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IILLTT  CCAALLEENNDDAARR  

In addition to the Event Calendar, DOI LEARN provides an Instructor-led Training 
Calendar, known as the ILT Calendar. Instructor-led training is automatically added to 
the ILT calendar when a class is created. Users of DOI LEARN can refer to this calendar 
to see which instructor-led courses are occurring on a specific day. Like the Event 
Calendar, the ILT Calendar provides users with five different views: a daily view, weekly 
view, monthly view, quarterly view and yearly view.  

The calendar screen also provides a Search feature enabling users to search for courses at 
specific locations or assigned rooms. The calendar cannot be search by both location and 
assigned room. If attempted, the search will default to locating assigned rooms. 

The ability to add events to the ILT Calendar works the same as it does in the Event 
Calendar. The only difference is that there are no Posters assigned. Only the Department 
Head and the Instructors can add events to the ILT Calendar. 

Navigating to the ILT Calendar 

1. Click the Communication tab. 

2. Click the ILT Calendar sub-tab or link. 

Filtering the ILT Calendar by Location or Room 

1. Navigate to the ILT Calendar. 

2. Search by training facility or assigned classroom: 

a. From the Location drop-down, select the desired training facility. 

b. From the Room drop-down, select the desired classroom. 

3. Click the Filter Sessions button. 
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Locating and Registering for a Course  

To Locate a Course 

1. Navigate to the ILT Calendar. 

2. If desired, filter by location or classroom to reduce the number of courses 
appearing on the calendar. 

3. To view a class offered on a particular day, do one of the following: 

a. If the Jump to Today or Week View link is selected, the current view is 
the day view. 

b. If the Month View is selected, click the Course link on the day the class is 
scheduled. 

c. If the Quarter or Year View is selected, click the C link on the day the 
class is scheduled. 

4. Within each view, a user can navigate to the previous and next periods by clicking 
the Previous and Next buttons. Click on a specific day's C or Course link for 
detailed information. 

To Register for a Course 

1. Locate the course in the ILT Calendar. 

2. Click the View link to view the detailed information. 

3. If a class is found and the registration time frame is still open, you may proceed 
with registration. 

4. Click the Preview Schedule button. Refer to Registering for a Course for further 
information. 
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MMYY  CCOOUURRSSEESS  

The My Courses page lists all of the courses and tasks for which a student is registered. 

To Exit an Online Course Correctly 

You must exit a course by clicking on the word exit in the course. If you click the X in 
the upper right hand corner of your course window without clicking exit, your scores will 
not be saved and recorded on your student transcript. 

If your test score is not saved while you are in a course, click your browser's Refresh 
button to show the test score. You may need to clear the cache on your browser or 
uninstall and reinstall the browser. The Managing Browser Cookies topic provides 
instructions on how to delete temporary Internet files. 

Navigating to My Courses 

1. Click the Classroom tab. 

2. Click the All Training sub-tab. 

Note: The My Courses button in the Quick Link bar takes you directly to 
the All Training page. 

Viewing a List of Your Registered Courses 

1. Navigate to My Courses. 

2. The following section(s) will be shown: 

• List of Online Registered Courses. To view only your online courses, click 
the Online Courses sub-tab. 

• ILT Schedule. To view only your classroom training, click the Instructor-
Led Courses sub-tab. 

• The Learning Plans you have been assigned. To view only your learning 
plans, click the MyPlan sub-tab. 
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Online Course Information 

1. Course Name 

• To launch a course. 

• Certain courses require you to take the test and survey from within the 
actual course. The remaining courses will have a Test or Survey link in the 
Options column. 

2. Status: Upon successful completion of a course, the status is updated from 
Incomplete or Not Attempted to Completed. An online course is complete when 
the test has been taken and passed. 

• Not Attempted 

• Incomplete 

• Completed 

3. Options 

• View Summary: displays the course information. 

• References: displays the references attached to an online course created 
with a specific authoring tool. 

• History: displays your status in the course. 

• Test(s): displays your status for the tests and test scores if completed. 

• Survey(s): launches the course survey. 

• Feedback: launches a new window in which to rate the course. This 
information will appear with the course details in the course catalog. 

• Completion Certificate: print a certificate to keep for your records or 
submit to your supervisor. 
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Instructor-Led Course Information 

1. Class Name/Course Name: view the details of the class. 

2. Dates, Time, and Days of the class 

3. Options 

• Drop Class: if there is a conflict in scheduling, this allows you to drop this 
class session. 

• Register: if you have been assigned by an administrator to take this course, 
you must select the actual class to take. To view the class sessions 
available, click the Register link. 

• Test(s): takes you to the Testing page. 

• Survey(s): takes you to the Survey page. 

• View Conflicts: notifies you if this class conflicts with another class for 
which you are currently registered. 

To Change the Order of the All Training Page 

1. Click the Administration tab. 

2. Click the My Preferences sub-tab. 

3. From the drop-down lists, select the desired order of your All Training page. 

The MyPlan page is a collection of learning plans that are created by the Department 
Head and the Instructors to assign curricula to students. A student's learning plans are 
also found on their All Training page. 

A learning plan is a single series of tasks that are related in nature and part of individual 
or group training. This benefits individuals and groups of employees who share career 
development goals, must comply with legal mandates, or need to maintain specific types 
of certification. It also provides a method for administrators to guide and track their 
employees on curriculum, certifications, or goals. 

Students assigned to a learning plan are automatically registered for all courses in that 
learning plan, though for instructor-led courses the student must select the class session 
that works best with their schedule to be registered to that course. Use the MyPlan page 
or the All Training page to view your learning plan and course details, launch a course, 
and view information about tasks that were assigned to you. 

To Access your Learning Plans 

1. Click the Classroom tab. 

2. Click the MyPlan sub-tab or link. 
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To View Learning Plan Information 

1. Task: the course and task names assigned through this learning plan. 

2. Status 

• Not Attempted 

• Not Registered: only for instructor-led courses, to select the class date and 
time to attend, click the Register link. 

• Not complete 

• Complete(d) 

3. Score: the score of the actual test for the course, the scores for any practice tests 
will not be shown. 

4. Due Date: when this task is due. 

5. Type 

• User Defined Task: this is a task that has been assigned to you that 
typically is not part of DOI LEARN. When this task has been completed, 
notify your supervisor who will then update the status of the task to 
complete.  

• Online 

• Instructor-led 

6. User Defined Task Options 

• View Summary: description of the task. 

7. Online Course Options 

• View Summary: displays the course information. 

• References: displays the references attached to an online course created 
with a specific authoring tool. History: displays your status in the course. 

• Test(s): displays your status for the tests and test scores if completed. 

• Survey(s): launches the course survey. 

• Feedback: launches a new window in which to rate the course. This 
information will appear with the course details in the course catalog. 

• Completion Certificate: print a certificate to keep for your records or 
submit to your supervisor. 

8. Instructor-Led Options 

• Register: allows you to select the class date and time. 

• All other options are available on the ILT Schedule pane or the Instructor-
Led Courses page. 

The courses and tasks within your learning plan are coded as follows: 
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Icon What It Means 

Date 
Assigned 

The date that this learning plan was assigned. 

Date 
Due 

The due date for completion of the entire learning plan. 

 
Indicates an instructor-led course.  

 
Indicates an online course. 

 
Indicates user-defined tasks.  

 Indicates a certification course. 

Red Due 
Dates 

Indicates the task is overdue. 

 

Viewing Course Information 

To View the Information of an Online Course 

1. Navigate to My Courses. 

2. In your registered courses list, locate the desired course. 

3. In the Options column, click the Summary link. 

4. Click the Close Window link. 

To View the Information of an Instructor-Led Course 

1. Navigate to My Courses. 

2. In your registered courses list, click the desired course title.  

3. Click the Close Window link. 
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Viewing a Class Roster 

You can view a list of the students who are registered in certain online courses you are 
taking. For an instructor-led class a roster is viewed from within the Course Catalog. 

1. Navigate to My Courses. 

2. Click a course title. A row of tabs will appear across the top of the screen.  

Note: If the course automatically loads the class roster feature is not 
available. 

3. Select the Class tab. 

Sending an E-mail to an Instructor 

1. Navigate to My Courses. 

2. For an online course: 

a. In the Options column, click the View Summary link for the course. A 
Course Summary pane appears. 

b. Click the instructor's email address link. 

3. For an instructor-led course: 

a. Click the course name. 

b. Copy/paste the instructor's email address into your email program. 

Sending an E-mail to Other Students 

Some online courses allow student to email other students. This options exists only when 
the students are registered for the same online course. 

To Send an E-mail to All Class Members 

1. Navigate to My Courses. 

2. Click an online course title. A row of tabs will appear across the top of the screen.  

Note: If the course automatically loads this feature is not available. 

3. Select the Class tab. 

4. Click the Mail All link. An email window opens.  

5. Complete the form and click the Send button. 



My Courses 

41 

To Send an E-mail to One Class Member 

1. Navigate to My Courses. 

2. Click an online course title. A row of tabs will appear across the top of the screen.  

Note: If the course automatically loads this feature is not available. 

3. Select the Class tab. 

4. Click the student's E-mail link. An e-mail window opens. 

5. Complete the form and click the Send button. 

Taking an Online Course 

1. Navigate to My Courses. 

2. In the list of registered courses, click the course name.  

3. If the course automatically launches. 

a. Select a version of the course. 

b. Click the Start your Session link. 

c. Advance through the course and assessments according to the directions. 

4. If the first page of the course opens, along with a series of tabs that allow you to 
view information about the instructor and others students taking the course. 

a. Navigate through the course using the arrows or selecting the desired page 
from the drop-down. 

b. To email the instructor, click the Contact tab. 

c. If available, to view the class roster and email registered students, click the 
Class tab. 

d. To view your current status in the course, click the Status tab. 

e. After you review the course information, use the Testing or Survey tabs 
to access any course tests or surveys that are available. 

f. To view any completed test scores, click the Score tab. 

5. If a new pop up window opens containing details of the course, you are taking a 
LCMS course. See Taking an LCMS Course. 
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Taking a Survey 

Surveys can be used to gauge your reaction to a portion of a course or to find out what 
you think about a potential course policy change. There are two types of online courses in 
the system. One type shows the Survey link in the Options column on the All Training 
page. The other type, the surveys do not appear until the course title link is clicked and 
you enter the course.  

1. Navigate to My Courses. 

2. In the list of registered courses, locate the desired course. 

3. In the Options column, click the Survey link. 

4. If a Survey link is not available: 

a. In the list of courses to which you are registered, click a course title. A 
row of tabs for that course will display. 

Note: If the course automatically loads this feature is not available. 

b. Select the Survey tab. 

c. Click the underlined survey name.  

d. Follow the on-screen instructions to complete the survey. You may only 
take a survey once for a particular course. 

Taking a Test 

There are two types of online courses in the system. One type shows the Test link in the 
Options column on the All Training page. The other type, the tests do not appear until the 
course title link is clicked and you launch the course.  

1. Navigate to My Courses. 

2. In the list of registered courses, locate the desired course. 

3. In the Options column, click the Test link. 

4. If the Test link is not available: 

a. In the list of courses, click the course title. Click the Test link appearing 
on the page. 

Note: If the course automatically loads this feature is not available. 

b. Select the Testing tab. 

c. Click the underlined test name and then click the Start Test button. 

d. Follow the on-screen instructions to complete the test.  
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Viewing Your Test Scores 

There are two types of online courses in the system. One type shows the Test link in the 
Options column on the All Training page. The other type, the tests do not appear until the 
course title link is clicked and you enter the course.  

1. Navigate to My Courses. 

2. In the list of registered courses, locate the desired course. 

3. In the Options column, click the Test link. 

4. Click the Score tab. 

5. If the Test link is not available: 

a. Click a course title. A row of tabs will appear across the top of the screen.  

Note: If the course automatically loads this feature is not available. 

b. Select the Score tab. Information regarding the tests and your scores will 
appear. 

Note: Course scores are shown only to the student who took the course. 
Supervisors cannot view a student's scores. They will only see whether the 
student passed or failed. 

Rating a Course 

When a student has completed a course, they can rate the course and add a comment 
using the Feedback feature.  

1. Navigate to My Courses. 

2. In your registered courses list, locate the desired course. 

3. In the Options column, click the Feedback link. The Feedback link will only 
appear after the course has been completed. 

4. In the Course Feedback window, select a number between one and five (with 
five being the highest rating). 

5. In the Comments box, type any comments you have about the course.  

Note: Your comments will be visible to everyone that accesses Learning 
Center while viewing course details within the Course Catalog. 

6. Click the Continue button.  

7. Click the Close Window button. 
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Printing a Course Completion Certificate 

Upon successful completion of an online course, your training Status will change to 
Completed. A certificate of completion is then available to print and save for your 
records or turn into your supervisor, if required. 

1. Navigate to My Courses. 

2. In the list of registered courses, locate the desired course. 

3. In the Options column, click the Completion Certificate link. The Completion 
Certificate is only available after the course has been completed. 

4. Print the certificate. 

Viewing Your References 

Learning objects and resources may be assigned to you from certain online courses. 
These items are displayed on the References page. These References allow you to review 
sections of the course based on the learning objects, keywords, or resources that are 
available. 

To View your Learning Objects 

1. Navigate to My Courses. 

2. Select the Reference tab. 

3. From the resulting list, click the desired learning object name. 

To Filter the List of Learning Objects 

1. From the Course Selection drop-down list, select the desired course name. 

2. Click the List link.  

3. To return to the full list after filtering, click the Clear link that appears to the right 
of the List link. 

To View your Resources 

1. Click the Resources button. 

2. Click a resource title. 

3. To save the file to your computer, click the Save button. To open it directly from 
Learning Center, click the Open button. 



My Courses 

45 

To View your Keywords 

1. Click the Keywords button. 

2. Click the keyword to view. This will open, in a separate window, a list of learning 
objects that contain that keyword. 

To Search for a Keyword 

1. Click the Search button. 

2. In the text box, type the keyword to search. 

3. Click the Search link. 

Viewing Your Student Transcript 

Your student transcript contains the following information: 

• username 

• full name 

• e-mail address 

• status within DOI LEARN 

• the number of times you have logged into DOI LEARN 

• all of your courses 

• the completion of test as pass or fail  

• all of your course registration and completion dates 

When you complete a test, your score for the test is listed in your transcript. If there are 
practice tests associated with a course, these scores will not appear. 

1. Navigate to My Courses. 

2. Select the Student Transcript sub-tab. 

3. From the Report Format drop-down, select the file type. 

4. Click the View Report button. 
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MMYY  IINNFFOORRMMAATTIIOONN  ((MMOOVVEE  HHIIGGHHEERR  OONN  LLIISSTT))  

Overview of My Information 

The My Information option allows you to view your user profile. This is the information 
related to the user name and password you use to log in to DOI LEARN. 

Navigating to My Information 

1. Click the Administration tab. 

2. Click the My Information sub-tab. 

Managing Your User Profile 

To Change your Password 

1. Navigate to My Information. 

2. In the Password text box, type your new password. 

3. In the Confirm text box, retype your new password. 

4. Click the Save button. 

To Edit your User Profile 

1. Navigate to My Information. 

2. Update the desired information in the editable fields of your user profile. 

3. If the information cannot be edited, please notify an administrator or your HR 
Department. 

4. Click the Save button. 
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MMYYPPLLAANN  AADDMMIINNIISSTTRRAATTIIOONN  ((MMOOVVEE  HHIIGGHHEERR))  

MyPlan is a component of the Learning Management System. It is a collection of 
learning plans that are created by the Department Head and the Instructors to assign 
curricula to students.  

A learning plan is a single series of tasks that are related in nature and part of individual 
or group training. Learning plans can be created and saved as templates that can be 
rapidly assigned to one or more students. This benefits individuals and groups of 
employees who share career development goals, must comply with legal mandates, or 
need to maintain specific types of certification. It also provides a method for 
administrators to guide and track their employees on curriculum, certifications, or goals.  

 

Students assigned to a learning plan are automatically registered for all the courses in that 
learning plan. Students can use the MyPlan options to view their learning plan and course 
details, launch a course, and view information about tasks that were assigned to them.  

Navigating to MyPlan Admin 

To Access the MyPlan Admin 

1. Click the Course Authoring tab. 

2. Click the MyPlan Admin sub-tab. 
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MMAANNAAGGIINNGG  IINNDDIIVVIIDDUUAALL  SSTTUUDDEENNTT  LLEEAARRNNIINNGG  
PPLLAANN  

A learning plan can be customized for a selected student. However, before a Department 
Head, Instructor or Supervisor can do this, they must create the learning plan template 
and assign it to the student. 

Locating a Student's Learning Plan 

1. Navigate to User Management. 

2. Search for the Student. 

3. In the resulting list, locate the desired Student. 

4. In the Learning Plan column, click the View link. 

• A Supervisor will only be able to view and manage those students they 
supervise. 

5. From the Select Learning Plan drop-down, select the appropriate learning plan. 

• This list shows only those learning plans to which the student has been 
assigned. 

6. Click the Go button. 

Adding Courses to an Individual Student's Learning Plan 

Once a Learning Plan has been created, there are times when a new course will need to be 
added. For both Online Training and Instructor-Led Training the steps to add courses are 
identical. Follow the steps below for each type of training.  

If the change is made in the template, it will only affect future students who are assigned 
to this learning plan. Students already assigned will not be affected. If the change is in an 
individual Student's learning plan, it will only affect this particular student.  

1. Locate the desired student's learning plan. 

2. Click the  add button next to the training type. 

3. To narrow the list of courses: 

a. Keyword: enter a keyword. 

b. Type: Online or Instructor-led. 

c. Category: select the category to which the course is assigned. 
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d. Click the Search button. 

 
4. In the resulting list, locate the desired course(s). 

5. In the Select a Course column, check the corresponding checkbox. 

6. Click the Submit button.  

Note: If a majority, but not all, courses listed need to be selected it may be 
more efficient to select Check All and then remove the checks for the 
courses that are not to be assigned. 

Updating User Defined Task Status 

When a student completes a user-defined task, the status of that task will need to be 
updated to reflect its completion. The task status can be updated for one student or for 
multiple students. 

To Update Task Status for a Single Student 

1. Locate the desired Student's learning plan. 

2. Locate the User Defined Tasks section. 

3. For each task that has been completed, click the Yes option. 

4. Click the Update Student Learning Plan button. 
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To Update Task Status for Multiple Students 

1. Navigate to User Management. 

2. Under Options, click the Assign User Defined Task Completions link. 

3. From the Select Learning Plan drop-down, select the desired learning plan. 

4. Click the GO button. 

5. From the Select User Defined Task drop-down, select the desired task. 

6. Click the GO button. 

7. From the All Student Grouping(s) drop-down, select the student's user group to 
narrow the list; otherwise, leave the default of All Student Grouping(s). 

8. Click the Filter button. 

9. In the Incomplete list, select one or more students who completed the task.  

10. Click the Update Students button.  
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Updating Due Dates and Reminders 

After a learning plan has been assigned to a student, it may be necessary to adjust the due 
dates and reminders for courses and tasks that were set when the learning plan was first 
assigned. These updates will only be changed for this individual student.  

1. Locate the student's learning plan. 

2. In the Overall Due Date text box, type the date (in MM/DD/YYYY format) by 
which the student should complete the course. 

3. In each Due Date text box, type the date (in MM/DD/YYYY format) by which 
the student should complete the course or task. 

4. To set reminders for 2, 7, 14, or 30 days, select the checkbox next to the label.  

For example, if you select the check box next to the 2 Days and 14 Days labels, the 
system will send students who are assigned to this learning plan an e-mail reminder 
14 days before the specified due date, and another e-mail two days before the due 
date. You can remove the check mark (and thus cancel the reminder) by clicking the 
box again to remove the check mark. 

5. Click the Update Student Learning Plan button.  

 



Managing Individual Student Learning Plan 

55 

Deleting a Student's Learning Plan 

A Department Head, Instructor or Supervisor can remove learning plans from a student's 
list of assigned learning plans.  

This process deletes the learning plan. Items also removed are the reference to due dates, 
any instructor-led courses the student had yet to register, and user defined tasks. The 
online courses and the instructor-led courses the student had registered for within the 
learning plan still remain in the student's training view. 

1. Locate the desired Student's learning plan. 

2. Click the Delete Plan button.  

3. A dialog will appear verifying the deletion, click the OK button. 
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OONNLLIINNEE  RREESSOOUURRCCEESS  

The Library features an Online Research and Learning Resources where you can access 
useful links to the Internet as well as additional resources that your organization has made 
available. Such resources may include the following: 

• Links to Libraries, such as the Library of Congress and the New York Public 
Library 

• Reference guides, such as dictionaries, maps, and the U.S. Postal service address 
and zip code lookup guide 

• News and weather services 

• Encyclopedias 

• Periodicals, such as newspapers and magazines 

• Search Engines 

• Training and Education Sites 

Navigating to the Online Resources 

1. Click the Library tab. 

2. Click the Online Resources sub-tab or link. 
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PPRROODDUUCCTT  LLIIBBRRAARRYY  ((LLEEAAVVEE  OOFFFF  FFOORR  NNOOWW??))  

The Product Library is your link to your company's physical library. Depending on the 
size of your organization, there may be multiple locations from which employees can 
check out materials. These separate locations are called Libraries.  

The Product Library has items such as CD-ROMs, videos, audiotapes, books, and print-
based materials available for users to check out and use, as well as files that they can 
download from any number of geographically dispersed locations. 

The first time a user accesses the Product Library the information page will appear. The 
required fields must be completed and then this user can use the Product Library and 
check out material. Note: A user is not part of the Product Library until their information 
is completed. This could affect Librarians handling requests for the user such as checking 
an item out to them or placing an item on hold. 

 
1. Click the Library tab. 

2. Click the Product Library sub-tab or link. 

User Permissions 

Librarians and Master Librarians maintain the libraries and the products that are offered 
by libraries.  

 

The Department Head and the Master Librarians can: 

• Appoint other Master Librarians and Librarians 

• Set up libraries and maintain information related to those libraries 

• Add items (also known as products) to libraries and edit information about items 
already in the library 

• Activate and deactivate items in the library 

• Check items into the library  

• Check items out of the library  

• Maintain the lists of available media types 

• Add and maintain categories and subcategories that allow for categorizing items 
in the library 

• View reports related to library functions and the status of library items 
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Librarians are limited to working within their local library. They can do the following: 

• Check items out to students 

• Check items into the library when students return them 

• Appoint a student as a librarian in his or her local library 

• Change local library information 

• Add items to the local library 

• View reports related to library functions 

• Add publishers 

   

All users of the system, including Master Librarians, Librarians, and non-Librarians are 
considered users. They can do the following in the Product Library: 

• Search for specific items and view details about those items 

• View all items in their local library 

• View items that you check out or placed on hold, and see a list of any unpaid fines  

• Place items in a book bag and then either check them out or remove them. As 
appropriate, the librarian will complete the check out process. Depending on the 
student's location, the option he or she chooses, and company policies, the 
librarian might send the item or the student might pick it up from the library.  

• Download or display electronic files that are listed as products in the library. 
Electronic files do not need to be checked out to the student by a librarian.  

• Renew an item that you checked out. You must do this within five days of the 
item's due date.  

• Cancel the hold on an item you no longer want. 

Completing Personal Information 

Before you can use the library, you will need to fill out the requested personal 
information. This ensures your privacy while still providing the Librarian with the 
necessary contact information and address in which to send the items you check out.  

1. Navigate to the Product Library. 

2. Click the Personal Information sub-tab. 
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3. Type or update the requested information on the user form.  

4. If a home library is not selected, from the Local Library drop-down, select the 
library that is closest to your home or work. 

5. Click the Save button.  

You can now view the information on the main menu page, search for items in the 
library, view your book bag, or check out items from the library. 

Searching by Keyword 

Users can search for an item in the Product Library using keyword search, advanced 
search, or by displaying a list of all library items. 

1. Navigate to the Product Library. 

2. Select the Search sub-tab.  

3. In the text box, type a keyword. 

4. Select either of the following: 

a. Entire Library: to search through all of the items in the Product Library. 

b. My Library: to search through only the items in your home library. 

5. Click the Submit Search button. 

 

Using the Advanced Search 

1. Navigate to the Product Library. 

2. Click the Search sub-tab. 

3. Click the Advanced Search button. The Advanced Search pane opens. 

Tip: To return to the previous search window and perform a keyword 
search or list the entire contents of the library, click Simple Search. 
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4. Use any or all of the following to narrow your search: 

a. Title: type a keyword of the title. 

b. Author: type the author's last name. 

c. Category: select the Category in which the item is located. 

d. Media Type: select the format of the item, such as a book, CD-ROM, file 
type, or DVD. 

e. Publisher: the organization that publishes and distributes the item, such as 
Random House or Knopf. 

f. Only New Items: select this check box to see only items that were 
recently added to the Product Library. 

5. Click the Search button. The results of the search display. Do either of the 
following: 

a. To view details about the title and other copies of that title, click a title in 
the search results. Then, you can either add the title to your book bag for 
check out, or choose another menu option.  

b. To return to the keyword search window and run another search, click the 
Simple Search button. 
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Viewing Item Details 

The Product Details pane in the Product Library allows users to view information about 
an item (also known as a product) in the library. Use this window to add an item to your 
book bag so that you can check it out from the library. 

Product details include the following: 

• The availability of the item: whether it is available, on hold, or checked out. 

• Title: complete name of the item. 

• Product code: This is the unique identifier that a librarian assigned to the item. 
The Library may contain multiple copies of a title, but each title will have its own 
product code. 

• Author: the author of the item. 

• Item description: a detailed description of the item. 

• Media type: If the media type is an electronic file, you can open it in your browser 
or save it.  

• Image (if available) of the item: this may be a snapshot of the cover. 

• Library that holds the item: Click the library name to see detailed information 
such as the location, hours, and contact details. 

• If there are additional copies of the item, they are listed below the product details. 
You can view details for each copy of the title. 

To View Details About an Item in the Library 

1. Navigate to the Product Library. 

2. Locate the item: 

• Keyword search 

• Advanced search 

• Look at a list of all items, click the Search button. 

3. Click the title of the item to view its details. The Product Details page opens. 

Place an Item in Your Book Bag and Continue Searching 

1. If the item is available, click the Add to Book Bag button.  

2. Click the Keep Searching button. The Search window opens. 
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To Place an Item On Hold 

1. If the item has been checked out by someone else, click the Add a Hold Request 
to Book Bag button. The request is placed on a waiting list for when the item 
becomes available. 

To Check Out Now 

1. To pick the item up from the library rather than having it sent, activate the I 
would like to pick up these items option. 

2. Click the Request Items button. The Main Menu opens and displays a 
confirmation message. 

To Remove an Item from the Book Bag 

1. Select the item and click the Remove Item button. 

To Download an Electronic Item 

If the media type for a library item is shown as an electronic file (sometimes this is shown 
as the type of file extension, such as .doc or .swf), you can open or download the file 
without placing it in the book bag for check-out. 

1. Click the file to download or open in the Electronic File box. The browser gives 
the option of downloading and saving the file or opening it for viewing. 

Item Options 

When the desired item in the library is found, it can be: 

• Placed in your book bag for check-out. 

• Placed on hold if it is not currently available. 

• Immediately downloaded if it is an electronic item. 

A librarian will determine whether the item can be checked out. If the librarian approves 
the check out, and depending on your location and the procedures used by your company, 
you can pick up the item or it will be sent to the address in the student's personal 
Information.  
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To Place an Item in your Book Bag 

1. Navigate to the Product Library. 

2. View the item's detailed information. 

3. If the item is available, click the Add to Book Bag button.  

4. To remove an item, select the item and click the Remove Item button. 

5. Click the Keep Searching button. The Search window opens. 

To Place an Item On Hold 

1. Navigate to the Product Library. 

2. View the item's detailed information. 

3. If the item has been checked out by someone else, click the Add a Hold Request 
to Book Bag button. The request is placed on a waiting list for when the item 
becomes available. 

To Remove a Hold on an Item 

1. Navigate to the Product Library. 

2. In the main menu, locate the item that you placed on hold in the Items On Hold 
section. 

3. Click the Cancel link to remove the hold. 

To Check Out Now 

1. The items can be sent to the address located in the Personal Information form or 
picked up from the Library. 

a. To pick the item up from the library rather than having it sent, select the I 
would like to pick up these items option. 

2. Click the Request Items button. The Main Menu opens and displays a 
confirmation message. 
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To Download an Electronic Item 

If the media type for a library item is shown as an electronic file (sometimes this is shown 
as the type of file extension, such as .doc or .swf), you can open or download the file 
without placing it in the book bag for check-out. 

1. Click the file to download or open in the Electronic File box. The browser gives 
the option of downloading and saving the file or opening it for viewing. 

Contacting a Librarian 

1. Navigate to the Product Library. 

2. View the item's detailed information. 

3. In the Product Details page, click the underlined name of the library. A pop-up 
window opens to display information about the physical location of the library 
and contact information, including a telephone number and email address. 

4. To send an email to the librarian, click the email address. An email window opens 
so that you can type the message and send the email. 

Viewing Checked Out Items 

Users can view a list of items that they have checked out from the Product Library. When 
the Product Library window opens, the Main Menu page displays a list of the items that 
are checked out. Information in this list includes: 

• Title of the checked out item 

• Date that it was checked out 

• Due date (when it needs to be returned the item to the library) 

• Status  

• If available, a link for renewing the item to extend the due date (this can only be 
done within five days of the renewal date) 

• The library from which the item was borrowed 

In addition to the list of checked out items, there is a listing of any items that were placed 
on hold and any unpaid fines that are due. 

1. Navigate to the Product Library. 

2. Review the list of items in the Items Checked Out pane. 
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Renewing Library Items 

Users can renew a library item any time within five days of its due date. 

1. Navigate to the Product Library. 

2. On the Main Menu page, locate the item to renew. 

3. Click the Renew link. A message displays stating whether the renewal was 
successful. 

4. Click the Close button. 

 

Selecting Your Local Library 

During the process of viewing item details or checking out an item, you can determine 
whether it is held at your home library or in one of the other libraries that the company 
maintains. This information is shown under the Product Details for each library item, and 
is kept up-to-date by Master Librarians and the Department Head.   

1. Navigate to the Product Library. 

2. Click the Personal Information sub-tab. 

3. From the Local Library drop-down, select the desired local library. To make it 
easier to pick up or receive materials you check out from the library, select the 
library that is closest to your home or work. 

4. Click the Save button.  

You can now view the information on the main menu page, search for items in the 
library, view your book bag, or check out items from the library. 
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RREEPPOORRTTSS  ((MMOOVVEE  TTOO  TTOOPP))    

The Department Head, the Instructors, and the Supervisors have the ability to generate 
detailed course statistics, test information and student proficiency metrics with the click 
of a mouse. Various reports provide detailed information on employee activity, number 
of attempts on a test, average scores, student's test score, passing scores, and courses 
started and completed.   

Reports can be generated in your choice of format, such as Portable Document Format 
(PDF), Microsoft Word and Excel, and Rich Text Format (RTF). The reports allow data 
to be filtered with the use of drop-down lists and keyword searches. A special "sort by" 
feature allows users to view their required data easily and conveniently. 

 

Note: Course scores are shown only to the student who took the course. 
Supervisors cannot view a student's scores; they will only see whether the 
student passed or failed.  

 

The available system reports within DOI LEARN include: 

• Course Analysis report 

• Email Utility report 

• Learning Plan Details report 

• Learning Plan Overview report 

• Student Summary report 

• Student Transcript report 

• Survey report 

• Test report 

• Test Statistics report 

• Usage report 

Navigating to the Reports 

1. Click the Administration tab. 

2. Click the Reports sub-tab. 
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TTYYPPEESS  OOFF  SSYYSSTTEEMM  RREEPPOORRTTSS  ((FFOOLLLLOOWW  
PPRREEVVIIOOUUSS  SSUUBBJJEECCTT))  

Course Analysis Report 

This report provides information about student status, whether or not they have 
completed a course, their score, as well as registration and completion dates. It also 
provides their status and e-mail address, and can display a complete list of classes for 
which all employees have registered. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Course Analysis Report, in the Actions column, click the Run link or 
Click the Course Analysis link. 

3. From the Report Format drop-down, select the document type. 

4. From the Student Status drop-down, select the status. Reports can only be run on 
Active and Suspended users, Deleted users do not appear in the reports. 

5. From the Completion Status drop-down, select the completion status. 

6. To view a specific Bureau or Region, select the appropriate Bureau or Region 
from the drop-down menu.  

7. Within the Completion Date Range section, enter a Start Date and an End Date 
using the MM/DD/YYYY format. Click the View Calendar link to select the 
dates from a calendar view. 

8. From the Course Type drop-down, select Online or Instructor-led. 

9. From the Course Name drop-down, select the course. 

10. Click the Go button. 

11. From the Class Name drop-down, select the class. If the information to include in 
the report is at the course level, a class does not have to be selected. 

12. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

13. Click the View Report button. 
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Email Utility Report 

This report allows you to e-mail students individually or e-mail multiple students as a 
group based on their class registration or completion status. This report includes student 
e-mail addresses. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Email Utility Report, in the Actions column, click the Run link or 
Click the Email Utility link. 

3. From the Student Status drop-down, select the status. Reports can only be run on 
Active and Suspended users, Deleted users do not appear in the reports. 

4. From the Completion Status drop-down, select the completion status. 

5. From the Course Name drop-down, select the course. 

6. Click the Go button. 

7. From the Class Name drop-down, select the class. If the information to include in 
the report is at the course level, a class does not have to be selected. 

8. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

9. Click the Get Student List button. 

Note: Sort the list by clicking the underlined column name. 

To Send an E-mail to an Individual Student 

1. Locate the student and click their e-mail address. 

2. In the Subject and the Body text boxes, type the desired information.  

3. To attach a document: 

a. Click the Browse button. 

b. Locate the desired file. 

c. Click the Open button. 

4. Click the Send button to send the email; otherwise, click the Cancel button to 
return to the Email Utility search criteria. 
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To Send an E-mail to All Students Included in the Report 

1. Click the Mail All link below the course name. 

2. In the Subject and the Body text boxes, type the desired information.  

3. To attach a document: 

a. Click the Browse button. 

b. Locate the desired file. 

c. Click the Open button. 

4. Click the Send button to send the email; otherwise, click the Cancel button to 
return to the Email Utility search criteria. 

Learning Plan Details Report 

This report features the percent complete for each learning path, as well as detailed 
information about the progress of this learning plan, including task name and type, 
completion status of each task, scores, due dates, and completion dates. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Learning Plan Details Report, in the Actions column, click the Run 
link or Click the LP Details link. 

3. From the Report Format drop-down, select the document type. 

4. To locate a specific student, in the Student Last Name text box, type all or part 
of the student's last name. 

5. From the Student Status drop-down, select the status. Reports can only be run on 
Active and Suspended users, Deleted users do not appear in the reports. 

6. From the Learning Plan drop-down, select the learning plan. 

7. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

8. Click the View Report button. 
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Learning Plan Overview Report 

This report shows the student's name, e-mail address, the learning plan that have been 
assigned to him or her and the date it was assigned, as well as its due date. It also displays 
the percent of each learning plan that is complete and the date of the most recent task 
completion. This report can be run to display all users who have not been assigned a 
learning plan as well. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Learning Plan Overview Report, in the Actions column, click the 
Run link or Click the LP Overview link. 

3. From the Report Format drop-down, select the document type. 

4. From the Student Status drop-down, select the status. Reports can only be run on 
Active and Suspended users, Deleted users do not appear in the reports. 

5. In the Show Students Without Learning Plan(s) option group: 

a. Yes: includes all students in the report. 

b. No: only lists the students with the selected learning plan. 

6. From the Learning Plan drop-down, select the learning plan. 

7. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

8. Click the View Report button. 

Student Summary Report 

This report allows users to review the details for each student and their historical course 
information. A student history report is generated showing the number of courses he or 
she is registered for, the number of courses that student has completed, the number of 
times the student has logged in to the site, as well as the total time logged in. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Student Summary Report, in the Actions column, click the Run link 
or Click the Student Summary link. 

3. From the Report Format drop-down, select the document type. 

4. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

5. Click the View Report button. 
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Student Transcript Report 

This report pulls a student transcript for one (or many) students that includes all of the 
student's demographic and contact information, as well as the number of times he or she 
has logged into system. This report shows course information that includes the following: 
course name, required passing score, score achieved, and registration and completion 
dates. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Student Transcript Report, in the Actions column, click the Run link 
or Click the Student Transcript link. 

3. From the Report Format drop-down, select the document type. 

4. From the Student Status drop-down, select the status. Reports can only be run on 
Active and Suspended users, Deleted users do not appear in the reports. 

5. To view only transcripts from a specific bureau select the appropriate bureau from 
the drop-down menu.  

6. To locate a specific student, in the Student Last Name text box, type all or part 
of the student's last name. 

7. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

8. Click the View Report button. 

Survey Report 

This report provides a statistical summary providing student name, the date of the survey, 
and the student's response to each question in the survey. The user can choose the layout 
in which they want to view the report: a list (by student), statistics (by survey question), 
or a bar chart (by survey question). 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Surveys Report, in the Actions column, click the Run link or Click 
the Surveys link. 

3. From the Select a course drop-down, select the course. 

4. Click the Go button. 

5. From the Select a Survey drop-down, select the survey. Only the surveys for the 
selected course appear in the list. 

6. Click the Go button. 
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7. After the report is run, you can select the appropriate layout for the report from 
the Select a View Option section:   

a. Click the List link to view the responses in a list by student. This is the 
default view. 

1. To delete the survey information, click the Delete button. 

2. Dialog appears verifying the deletion, click the Delete button to 
complete the deletion; otherwise, click the Back button. 

b. Click the Statistics link to view the statistical information by survey 
question. 

c. Click the Bar Chart link to view the responses by survey question. 

Test Report 

The test report enables a supervisor to view which students took a particular online test, 
their score on the test, what the pre-set passing score is, and how many times each student 
took the test. The report allows you to sort by last name, first name, student status, class, 
date the test was taken, the score received, and the required passing score. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Test Report, in the Actions column, click the Run link or Click the 
Test Report link. 

3. From the Select a course drop-down, select the course. 

4. Click the Go button. 

5. From the Select a test drop-down, select the test. Only the tests for the selected 
course appear in the list. 

6. Click the Go button. 

Note: Sort the list by clicking the underlined column name. 

Test Statistics Report 

This report shows various statistics regarding a course. The information shown includes: 
course title and corresponding test title, the maximum possible score, average score, 
average score percentage, required passing percentage, average time for test, times the 
test is allowed to be taken, and the number of times the test was taken. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Test Statistics Report, in the Actions column, click the Run link or 
Click the Test Stats link. 
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Usage Report 

This report provides detailed information such as student name, e-mail address, number 
of logins, and total time logged in to the system. It gives an overview of how DOI 
LEARN is being utilized by your students. 

1. Navigate to the reports. In the Main window, click the System Reports link. 

2. Locate the Course Analysis Report, in the Actions column, click the Run link or 
Click the Course Analysis link. 

3. From the Report Format drop-down, select the document type. 

4. From the Student Status drop-down, select the status. Reports can only be run on 
Active and Suspended users, Deleted users do not appear in the reports. 

5. To locate a specific student, in the Student Last Name text box, type all or part 
of the student's last name. 

6. Within the Login Date Range section, enter a Start Date and an End Date using 
the MM/DD/YYYY format. Click the View Calendar link select the dates from a 
calendar view. 

7. From the Course Type drop-down, select Online or Instructor-led. 

8. In the Students to display option group: 

a. All students: displays all students within the system who match the 
Student Status criteria. 

b. Only students who have logged in: displays only student who have 
logged in that match the Student Status criteria. 

9. From the Sort By drop-down, select the field on which the information will be 
ordered alphabetically. 

10. Click the View Report button. 
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UUSSIINNGG  TTHHEE  DDYYNNAAMMIICC  RREEPPOORRTTIINNGG  EENNGGIINNEE  
((FFOOLLLLOOWW  PPRREEVVIIOOUUSS))  

Overview of Dynamic Reporting 

DOI LEARN has the ability for the Department Head to create custom reports and share 
these reports with other administrators. When the Department Head, the Instructors or 
Supervisors receive a report that has been shared with them it will appear in the All 
Reports section. Any updates the original creator makes on the report will also be applied 
to this report. The report can be copied to preserve the current state and then edited to 
customize the report. A copied report will then appear in the My Reports section. These 
changes will only affect the copy of the original report. A benefit of making a copy of the 
original report is that, if the creator deletes it, the original will be removed from the All 
Reports section of anyone with whom it has been shared. Custom reports can be exported 
as a .csv file, which can be viewed and saved as an Excel spreadsheet. 

Tips for Finding a Report 

• Sort columns by fields; this will help group similar names and attributes together 
to make the list easier to scan.  

• When creating your own reports, add unique, clear names and descriptions. These 
will help you find them later and similarly assist people with whom you share the 
report.  

• Click Details to view more detailed information about a report.  

• If the report was shared with you, the creator may have modified or deleted it.  

Viewing a Report 

1. Navigate to the reports. 

2. Click the My Reports or All Reports link. 

3. Locate the desired report and in the Actions column, click the Run link. 

4. View the detailed list of information regarding the report using the Result Page 
links to view additional records. 

a. To view more records on each page, from the Display ## Records Per 
Page drop-down, select 10, 25, 50, or 100. 

b. Click the GO button. 
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5. Optionally, the following actions can be performed on the report: 

a. Edit Report 

b. Export to CSV 

c. Return to All Reports, returns to the All Report view. 

d. Return to My Reports, returns to the My Reports view. 

Exporting a Report 

1. Navigate to the reports. 

2. Click the My Reports or All Reports link. 

3. Locate the desired report, in the Actions column, click the Details link. 

4. Click the Run button to return the filtered records. 
     

 
5. Click the Export to CSV button. 

6. Click the Download Report link to download; otherwise, click the Close 
Window link. 

7. Click the Open or Save button on the File Download window. 

   

When a report is exported, the report is first created on the server, at which point the 
browser handles the file according to the browser settings (by either prompting for action, 
requesting a location to save the file, or launching the default viewer for that file type). 
The file name will resemble the following: 

xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx.ext  

This filename is a unique combination of numbers and letters to track the report on the 
server and protect it from unauthorized download. The file can be safely renamed to 
something easier to remember when the browser prompts you to save the file to disk. 
Alternatively, you may rename the file on your system once it has been downloaded. 
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Copying a Report 

1. Navigate to the reports. 

2. In the Main window, click the All Reports or My Reports link. 

3. Locate the report, in the Actions column, click the Copy link. 

4. In the New Report Name text box, type the new name. 

5. In the New Description text box, type the new description. 

6. Click the Copy Report button. 

7. A message will appear stating "Report Copied. A copy of this report is now 
available to you as the new report name." This report will appear in the All 
Reports and the My Reports views. 

8. Click the Close button. 

This version of the report can now be run, edited, shared, copied or deleted.  

Note: Concerning a copied report, any changes made to the original will 
not appear automatically in your copy. You must alter your copy yourself 
or make a new one from the altered original. In addition, if the original is 
deleted by the creator it will be removed from your All Reports view. 
However, you will not loose your copied version. 

Renaming a Report 

1. Navigate to the reports. 

2. In the Main window, click the My Reports link. 

3. Locate the report, in the Actions column, click the Rename link. 

4. In the Report Name text box, type the new name. 

5. In the Description text box, type the new description, if desired. 

6. Click the Rename Report button. 

7. A message will appear stating "Renaming Report. The name of your report has 
been changed." 

8. Click the Close button. 
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Editing a Report 

1. Navigate to the reports. 

2. The Edit feature is only available from the My Reports view. Refer to Copying a 
Report to transfer a copy of a report located in All Reports to My Reports. 

3. In the Main window, click the My Reports link. 

4. Locate the report, in the Actions column, click the Edit link. 

5. Update the information as desired for Steps 1 - 5. Refer to Creating a Report for 
instructions. 

6. For Step 6 - Save Your Report do one of the following: 

a. To save using the current report name. 

1. Select the Overwrite Existing Report option.  

2. Click the Next button. 

3. To run the report now, check the Run this dynamic report now 
check box. 

4. Click the Finish button. 

b. To save using a different name and create a new report while saving the 
old version. 

1. Select Save and Run New Report option.  

2. Click the Next button. 

3. In the Title text box, type the new name. 

4. In the Description text box, type the new description. 

5. To run the report now, check the Run this dynamic report now 
check box. 

6. Click the Finish button. 

Note: Concerning a copied report, any changes made to the original will 
not appear automatically in your copy. You must alter your copy yourself 
or make a new one from the altered original. In addition, if the original is 
deleted by the creator it will be removed from your All Reports view. 
However, you will not loose your copied version. 
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Filtering a Report 

1. Navigate to the reports. 

2. In the Main window, click the All Reports or My Reports link. 

3. Locate the report, in the Actions column, click the Filter link. 

4. Edit the values in which to filter. Leaving a filter blank will default to all. 

a. A text field displays a Value text box with an icon to look up possible 
values. Enter the value and click the Insert button, the filtering value will 
appear in the second text box. To add more than one value click the OR 
button to insert any additional values.   

• A wild card feature is available. Use the % symbol at the 
beginning or within the value as the wild card. The wild card is 
added to the end by default, therefore do not type a % at the end of 
a value. e.g. - Course status can enter '%comp' to find all 
Incomplete, Completed, and Complete statuses. 

 
b. A date field includes start and end date text boxes with calendar lookup 

icons. Enter a date range using the MM/DD/YYYY format. Leave a date 
blank to search for all items before or after the opposite entered date, 
respectively. 

 
c. A numeric field includes three option groups and a text box. Enter a 

numerical value to filter by, and select whether the filter will return 
records with a value greater than or equal to, equal to, or less than or equal 
to the entered value. 

  

5. Click the Finish button. 
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Deleting a Report 

1. Navigate to the reports. 

2. The Delete feature is only available from the My Reports view.  

3. In the Main window, click the My Reports link. 

4. Locate the report, in the Actions column, click the Delete link. 

5. A dialog will appear verifying the deletion. Click the OK button to delete; 
otherwise, click the Cancel button. 

Caution: If the report being deleted, is a report that has been shared with 
other users it will be removed from their All Reports view upon deletion. 

Dynamic Reporting Data Dictionaries 

When you are creating a custom report using the Dynamic Reporting Engine, the first 
step is to select the view in which the report will be based. The fields available in each 
view are listed below for the following views: 

• Approval Queue 

• Course Feedback 

• Course Summary Statistics 

• E-Commerce Transactions 

• ILT Attendance 

• User Course Details 

• User Learning Plan Details 

Approval Queue Data Dictionary 

Field Label Description 

Approval Status The current approval status such as Awaiting 
Approval, Approved, Denied, Course Canceled, 
Course Replaced, Course Deleted 

Beginning Date The beginning date 

Class Location The location of the class.  

Class Name The name of the class in which the student is 
requesting approval 
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Course Name The name of the course in which the student is 
requesting approval 

Course Type OLT, ILT 

Email Student’s email address 

End Date The final date of the class 

Extension Student’s phone extension 

First Name Student’s first name 

Funding Source Code The funding code 

Language The interface language 

Last Name Student’s last name 

Material Cost The cost of materials 

Middle Initial Student’s middle initial 

Office Phone Student’s office phone number 

Request Date The date when the student requested the registration 
for the class 

Response Date The date that the student received a respond from 
his supervisor 

Responder Email The email address of the person who responded to 
the student’s request 

Responder First Name The first name of person who responded to the 
student's request 

Responder Last Name The last name of the person who responded to the 
student's request 

Response Date The date of response 

Supervisor Yes, No 

Times In Number of times the student accessed the site 

Travel Cost Total cost of travel 

Total Time On Total time the student spent on the site 

Tuition Cost The cost of tuition 

User Creation Date The date the user was added to the system 

User Name Student’s user name 

User Status Active, Suspended, Deleted 
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User Type Department Head, Instructor, Supervisor, Student 

Course Feedback Data Dictionary 

Field Label Description 

Class Name The name of the class 

Comments Student's feedback on a course 

Course Creation Date The date when the course was created in the 
database 

Course Name Course name 

Course Status Live, Not Live 

Email Student’s email address 

Extension Student’s phone extension 

First Name Student’s first name 

Language The interface language 

Last Name Student’s last name 

Middle Initial Student’s middle initial 

Office Phone Student’s office phone number 

Rating Rating for the course 

State The state 

Supervisor Yes, No 

Times In Number of times the student accessed the site 

Total Time On Total time the student spend on the site 

User Creation Date The date when the user was added to the system 

User Name Student’s user name 

User Status Active, Suspended, Deleted 

User Type Department Head, Instructor, Supervisor, Student 

Vendor CourseID Course ID that is provided by the vendor 

Vendor Name Vendor name 
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Course Summary Statistics Data Dictionary 

Field Label Description 

Average Stars The average of number of starts that the course 
received 

Bureau Bureau 

Class Name Class name 

Completion Count Number of times this course has been completed by 
all students 

Completion Date The date of completion 

Completion Status The status  

Course Creation Date The date the course was created in the system 

Course Name Course name 

Course Start Date The start date of a course 

Course Status Live, Not Live 

Course Type OLT, ILT 

Org Code The organizatoinal code 

Region The region 

Registration Count Number of courses in which students have 
registered 

Registration Date The date of registration 

Registration Status The registration status 

Student Completion 
Count 

The student count at completion 

Vendor CourseID Course ID that is provided by the vendor 

Vendor Name Vendor name 

E-Commerce Transactions Data Dictionary (release 2) 

Field Label Description 

Authorization Code Authorization Code that is assigned to the 
transaction 

Class Name Class name 
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Comment Text that describes the current transaction 

Course Name Course name 

Course Status Live, Not Live 

Course Type OLT, ILT 

Course Creation Date The date the course was created in the system 

Date Of Purchase Date of purchase 

Discount Discount amount 

Email Student’s email address 

Extension Student’s phone extension 

First Name Student’s first name 

Language The interface language 

Last Name Student’s last name 

Middle Initial Student’s middle initial 

Office Phone Student’s office phone number 

PricePaid Total price that the student paid 

PurchaseID ID number for the purchase order 

Quantity Number of items the student purchased 

Supervisor Yes, No 

Times In Number of times the student accessed the site 

Total Time On Total time the student spent on the site 

User Creation Date The date the user was added to the system 

User Name Student’s user name 

User Status Active, Suspended, Deleted 

User Type Department Head, Instructor, Supervisor, Student 

Vendor CourseID Course ID that is provided by the vendor 

Vendor Name Vendor name 
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ILT Attendance Data Dictionary 

Field Label Description 

Attendance Present, Absent 

Attendance Note Notes from the attendance utility 

Bureau The bureau 

Class Name Class name 

Class Session End Finishing date for the class session 

Class Session Start Starting date for the class session 

Completion Status The completion status 

Course Code The course code 

Email Student’s email address 

Extension Student’s phone extension 

First Name Student’s first name 

Language The interface language 

Last Name Student’s last name 

Middle Initial Student’s middle initial 

Office Phone Student’s office phone number 

Org Code The organization code 

Region The region 

Registration Status The status of registration 

Supervisor Yes, No 

Times In Number of times the student accessed the site 

Total Time On Total time the student spent on the site 

User Creation Date The date the user was added to the system 

User Name Student’s user name 

User Status Active, Suspended, Deleted 

User Type Department Head, Instructor, Supervisor, Student 
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User Course Details Data Dictionary 

Field Label Description 

Bureau The bureau 

Certification Due Date Certification Due Date 

Class Name Class name 

Completion Date The date the student completed the course 

Course Name Course name 

Course Start Date The date the student started the course 

Course Type ILT, OLT 

Courses Completed Number of courses the student has completed 

Courses Registered Number of courses in which the student is registered 

Courses Waived Number of courses marked waived for the student 

Email Student’s email address 

Extension Student’s phone extension 

First Name Student’s first name 

Justify Waiver Text to describe the waiver reason 

Language The interface language 

Last Accessed Date Last date the student accessed the course 

Last Name Student’s last name 

Lesson Status Completed, Incomplete, Not Attempted 

Middle Initial Student’s middle initial 

Office Phone Student’s office phone number 

Org Code The organizational code 

Region The region 

Registration Date The date the student registered for the course 
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Registration State Previous, Current 

Previous - OLT are Dropped courses;  

Previous - ILT are classes that have occurred based 
on the current date;  

Current - OLT are courses for which a student is 
currently registered;  

Current- ILT classes that have yet to occur based on 
the current date 

Score The student’s test score provided it exists 

Supervisor Yes, No 

Test Attempts Number of times the student opened the test 

Times In Number of times the student opened the site 

Total Time On Total time the student spent on the site 

User Creation Date The date the user was added to the system 

User Name Student’s user name 

User Status Active, Suspended, Deleted 

User Type Department Head, Instructor, Supervisor, Student 

Waive Reason The reason why the student was waived from the 
course 

User Learning Plan Details 

Field Label Description 

Completion Date The date of completion 

Completion Status Completed, Not Attempted 

Email Student’s email address 

Extension Student’s phone extension 

First Name Student’s first name 

Item Due Date The due date for the learning plan item 

Language The interface language 

Last Name Student’s last name 

Learning Path The name of the learning plan 
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Learning Path 
Description 

Text describing the learning plan 

Middle Initial Student’s middle initial 

Office Phone Student’s office phone number 

Org Code The organizational code 

Path Assigned Date The date the learning plan was assigned to the 
student 

Path Due Date The due date that the student has to complete his 
learning plan 

Registration Status The registration status 

Score The student’s test score provided it exists 

Supervisor Yes, No 

Task Name The name of the task  

Task Type ILT, OLT, UDT 

Times In Number of times the student accessed the site 

Total Time On Total time the student spend on the site 

User Creation Date The date the user was added to the system 

User Name Student’s user name 

User Status Active, Suspended, Deleted 

User Type Department Head, Instructor, Supervisor, Student 
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SSFF--118822  ((MMOOVVEE  BBEELLOOWW  RREEPPOORRTTIINNGG  SSEECCTTIIOONNSS))  

  

The SF-182 Form (Request, Authorization, Agreement, and Certification of Training) is 
used to document the authorization and approval of training. It serves as supporting 
documentation for obligating and paying for training courses and provides a record for 
the employee.  

Administrator Privileges 

Section in the SF-182 
Administration  

DeptHead  Instructor Supervisor 

Entire SF-182 Form 
  

x x x 

Form Header 
  

x x x 

Section A – Trainee Information x x x 

Section B – Training Course Data x x x 

Section C – Estimated Costs and 
Billing Information 

x x x 

Section D – Approvals 
  

x x x 

Section E – 
Approvals/Concurrence 

x x x 

Section F – Certification or 
Training Completion 

x x x 

Approval or Deny Request 
  

x x x 

Form Comments 
  

x x x 

Form Transaction History 
  

x x x 
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Cancel Request 
  

x x  

Document High Dollar Training x x  

Email SF-182 Form 
  

x x  

Send Confirmation Email 
  

x x  

Printable SF-182 Form 
  

x x x 

Printable SF-182 Form Section G x x x 

Navigating to SF-182 Administration 

1. Click the Administration tab. 

2. Click the SF-182 Admin sub-tab. 

Overview of SF-182 Procedure 

The SF-182 Form (Request, Authorization, Agreement, and Certification of Training) is 
used to document the authorization and approval of training. It serves as supporting 
documentation for obligating and paying for training courses and provides a record for 
the employee.  

To gain approval for external training a student must: 

1. Complete the SF-182 form. Submitting a form will automatically generate two 
emails: 

• The Student receives notification that the form has been submitted. 

• The Student's direct Supervisors receive notification that the form is ready 
for review. 

2. Wait for confirmation of approval. 

• When the approval process is complete, the student will receive an email 
stating that the approval for training has been completed. 

3. Register for the course if approved. 
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Locating a User's SF-182 Form 

1. Navigate to SF-182 Administration. 

2. Filter for the desired user by any of the following: 

a. Last Name 

b. Vendor Name 

c. Request Status 

d. Submission Date Start 

e. Submission Date End 

3. Click the Search button. 

4. In the resulting list, locate the desired user. 

5. Click the Edit link. 
 

 

Completing the SF-182 Form 

All of the fields in the SF-182 form are required and must be completed in one sitting. 

1. Complete the form using your personal information. 

2. Click the Submit button. 
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Viewing a User's SF-182 Form 

1. Navigate to SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Click the Edit link. 

4. Locate the Entire SF-182 Form, click the Edit link. 
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Editing a User's SF-182 Form 

The entire SF-182 form or each section of the form can be viewed. While viewing, the 
content can be edited and/or a comment can be added for the Department Head, 
Instructors and Supervisors to view. The Department Head, Instructors and Supervisors 
can also add a comment from this screen. 

The sections available for viewing and editing are: 

• Form Header 

• Section A - Trainee Information 

• Section B - Training Course Data 

• Section C - Estimated Costs and Billing Information 

• Section D - Approval or Deny Request 

• Section E - Approvals/Concurrence 

• Section F - Certification or Training Completion 

To View and Edit a User's SF-182 Form 

1. Locate a student's SF-182 form. 

2. Locate the desired section, click the Edit link. 

3. Edit as desired. 

4. Click the Save button to save the changes and return; otherwise click the Back 
button to return without saving. 

Approving or Denying a Request 

The process to approve the training for a student requires two approval requests. 
Approval can be obtained either of the following ways: 

• The student's direct Supervisor and one Department Head or Instructor.  

• After the Department Head or Instructor completes the Approval or Deny 
Request section, they can then Send a Confirmation Email to complete the 
process. 

• Two Supervisor approvals: Both of these Supervisors must be specified in that 
student's User Profile.  

• If this process is selected a Department Head or Instructor must still Send 
a Confirmation Email for final approval to take place. 
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To Approve or Deny a Request 

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Locate the Approval or Deny Request section. 

4. Click the Edit link. 

5. Click the View/Add Comments button. 

6. In the Approve Request option group, select one of the following: 

a. If approved, select Yes. 

b. If not approved, select No. 

7. In the Comments text box, type the reason for the approval or denial. 

 
8. Click the Submit button. 

To Complete the Approvals/Concurrence Process 

This section will not be verified by the site and the procedure for completion will be 
based on your internal process. 

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Locate the Approvals/Concurrence section. 
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4. Click the Edit link 

5. Complete the necessary information. 

 
6. Click the Save button to save and return; otherwise click the Back button. 

To Complete the Certification or Training Completion  

This section will not be verified by the site and the procedure for completion will be 
based on your internal process. 

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Locate the Certification or Training Completion section. 

4. Click the Edit link. 

5. Complete the necessary information. 

 
6. Click the Save button to save and return; otherwise, click the Back button. 

Once the approval process is complete, the next step is to send a confirmation email. 

Managing Comment in a User's SF-182 Form 

In addition to adding comments a comment types can also be added from the section 
comments window, remember that once a comment has been added it cannot be deleted.  

To Add a Comment to a Section 

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Click the View/Add Comments button. 
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4. In the Type drop-down, select Approval. 

5. In the Comment text box, type a comment. 

6. Click the Submit button to save; otherwise, click the Cancel button. 

To Add a Comment Type 

To add a comment type the Department Head, Instructor or Supervisor must be in the 
View/Add Comments window for any of the SF-182 sections. Note that the View/Add 
Comments button is not accessible from the Entire Form section. 

1. Click the Manage Comment Types button. 

2. Click the Add Comment Type button. 

3. Type the new comment type. 

4. Click the Add Comment Type button to save; otherwise click the Cancel button. 

5. Click the Close Window link. 

View All of the Comments in the Form 

1. Locate the Form Comments section. 

2. Click the View link. 

3. View the comments that have been added to this form. 
  

 
4. A comment can also be added by clicking the Add Comment button. 

5. Click the Close Window link. 



DOI2d431 Supervisor User Manual 

102 

Sending Email Within the SF-182 Form  

Email a SF-182 Form 

An email is generated that includes a printable html of the SF-182 form and the form's 
comments. 

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Locate the Send Email section. 

4. Click the Send link. 

5. Insert the recipients email addresses, subject, and body. 

6. Click the Send button. 

Send a Confirmation Email 

The confirmation email Send link is only active if the entire approval process has been 
completed.  

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 

3. Locate the Send Confirmation Email section. 

4. Click the Send link. 

5. The following four selections appear: 

a. Create Course Admin will direct you to the LMS authoring tool to create 
the new course. 

b. Register Trainee Admin will direct you to the LMS student registration 
section to register for the course if it is located in the catalog.  

c. Confirmation Email Admin will allow you to create a confirmation 
email and send an attachment to this user. 

d. Return to Request Admin will close this window and return to the SF-
182 administration section for this student. 

Printing a User's SF-182 Form 

1. Navigate to the SF-182 Administration. 

2. Locate a student's SF-182 form. 
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3. Print the SF-182 form: 

a. Locate the Print the SF-182 form section 

b. Click the View link. 

c. Click the OK button on your print window to print; otherwise click 
Cancel. 

4. Print the SF-182 Section G form: 

a. Locate the Print the SF-182 form section G section 

b. Click the View link. 

c. Click the OK button on your print window to print; otherwise click 
Cancel. 

Locating the SF-182 Form in the Catalog 

To Access an Existing SF-182 Course 

1. Navigate to the Course Catalog. 

2. Click the Advanced Search link. 

3. In the Training Type option group, select SF-182 Requested. 

4. Click the Search button. 

5. In the resulting list, locate the desired course. 

6. Click the course title to access the SF-182 form. 

To Access Courses Not Found in the Catalog 

If an external training course cannot be found in the catalog, a student can request 
permission to take the training by submitting the SF-182 form. 

1. Navigate to the Course Catalog. 

2. Located on every page in the catalog, click the online SF-182 form link to access 
the SF-182 form. 
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UUSSEERR  MMAANNAAGGEEMMEENNTT    

The User Management feature allows you to search for users, assign users to courses, or 
maintain user information. The following tasks can be completed using the User 
Management module: 

• Create a new Student (or Supervisor). 

• Create a new Instructor. 

• Edit a Student's or an Instructor's profile. 

• View and edit a student's transcript. 

• View a user's activity log. 

• Assign multiple students to an online or an instructor-led course. 

• Assign a student to multiple online or instructor-led courses. 

• Assign waivers to students. 

• Manage a student's learning plan. 

• Manage drop reasons. 

• Assign user defined task completions. 

Navigating to User Management 

1. Click the Administration tab. 

2. Click the User Management sub-tab. 

Search for Users 

The Department Head, the Instructors and the Supervisors can view a list of all Learning 
Center users. The list includes each user's username, status, and links that will allow you 
to: 

• Send an e-mail to the user. 

• Edit the user's profile. 

• View the user's transcript. This shows a transcript of courses and classes taken 
and allows the administrator to update the Completion Status of a course as well 
as add Extra Transcript Items. 

• View an activity log for the user. This shows when the user was logged into the 
site and for how long. 
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• View the courses/categories available to the user and register him or her to 
courses. 

• Manage course waivers. 

• Manage a user's learning plans. 

To View a List of All Users 

1. Navigate to User Management. 

2. Use the system defaults (Search All) for the search criteria and click Search. 

To Filter for a Specific User or Group of Users 

1. Navigate to User Management. 

2. Select the desired Search Criteria: 

a. Where: select the field in which to search for your keyword. 

b. Contains Text: type the keyword.  

c. User Type: select the user type in which to search. 

d. User Grouping: select the user group in which to search. 

3. Click the Search button. 

Viewing a User's Activity Log 

The Department Head, the Instructors and the Supervisors may view a user's activity 
within DOI LEARN. The Activity Log shows a user's login and logout dates and total 
time spent in DOI LEARN. 

1. Navigate to User Management. 

2. Search for the desired user. 

3. In the resulting list, locate the desired user. 

4. In the Activity Log column, click the View link.  

Note: When a user does not log out properly, the Total Time is estimated 
by using the last activity date/time plus 10 minutes. 
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Assigning User Defined Task Completions 

The Department Head, the Instructors and the Supervisors can assign user defined task 
completions to students in a learning plan.  

1. Navigate to User Management. 

2. Select the Assign User Defined Task Completions link. 

3. From the Select Learning Plan drop-down, select the learning plan that contains 
the user defined task. 

4. Click the GO button. 
 

 
5. From the Select User Defined Task drop-down, select the task. 

6. Click the GO button.  

7. Click the Filter button. The list will return only student assigned to the selected 
learning plan. 

a. To narrow the list of students, from the drop-down, select a specific User 
Grouping. Click the Filter button.  

8. From the Incomplete list box, select the students to mark complete. 

9. Click the Update Students button. 

Assigning Waivers 

Waivers can be used to specify that a user has demonstrated competency for a class 
without taking the class. The Department Head, the Instructors and the Supervisors can 
specify whether to allow waivers for a particular course when creating or editing that 
course. They can also determine if a waiver has been applied to particular student by 
viewing the student's transcript report.  

1. The course must allow waivers. See Creating a Course for instructions. 

2. Navigate to User Management. 

3. Search for the student. 

4. In the resulting list, locate the desired student. 

5. In the Waivers column, click the Edit link.  

6. In the Select Course Type option group, select OLT or ILT. 

7. From the Courses Available for Waiver drop-down, select the course name. 
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Note: Only courses that are marked as eligible for waivers will appear in 
the list. 

8. In the Mark Course as Waived option group, select Yes to mark this course 
waived for this student; otherwise, select No. 

9. From the Reason for Waiver drop-down, select the desired reason. 

10. In the Justification for Waiver text box, type the reason the waiver was given. 

11. Click the Update button. 
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AADDDDIINNGG  AANNDD  EEDDIITTIINNGG  UUSSEERR  IINNFFOORRMMAATTIIOONN  

Editing a Student or Supervisor 

The Department Head, the Instructors and the Supervisors may edit the information for 
Students and Supervisors; however, Supervisors may only edit information for their 
subordinates. 

1. Navigate to User Management. 

2. Search for the student or supervisor. 

3. In the resulting list, locate the desired user. 

4. In the Edit column, click the Edit link.  
 

 
5. Update the information. Refer to Adding a Student or Supervisor for field 

information. 

6. Click the Save button. The system confirms the update and refreshes the 
window. If the password was reset, click the Save and send User Name and 
Password in email button to notify the user. 

Editing a Student's Transcript 

1. Navigate to User Management. 

2. Search for the student. 

3. In the resulting list, locate the desired student. 

4. In the Transcript column, click the Edit link. The Transcript Administration 
window opens. 

5. Locate the desired course to update. 

6. From the Completion Status drop-down, select the new status. 
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7. In the Completion Date text box, type the date the course was completed using 
the MM/DD/YYYY format. 

8. In the Score text box, type the score if available. This entry must be numeric. 

9. Click the Update Transcript button to save your changes. The system confirms 
the update and refreshes the window. 

To Add Extra Transcript Items 

1. From the Transcript Administration page, click the Add Extra Transcript Item 
button. A new window opens. 

2. In the Course Name text box, type the name of the course. 

3. In the Class Name text box, type the name of the class. 

4. From the Completion Status drop-down, select the status. 

5. In the Completion Date text box, type the date the course was completed using 
the MM/DD/YYYY format. 

6. In the Score text box, type the score if available. This entry must be numeric. 

7. In the Registration Date text box, type the date the Student registered for the 
course using the MM/DD/YYYY format. 

8. Click the submit button to save the item; otherwise, click the Close Window link 
to return to the Transcript Administration page. 

To View a Student's Transcript 

1. From the Transcript Administration page, click the View Student Transcript 
link. 

2. From the Report Format drop-down, select the desired format. 

3. Click the View Report button. 
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AASSSSIIGGNNIINNGG  UUSSEERRSS  TTOO  CCOOUURRSSEESS  

Assigning a User to an ILT Course 

To Assign One or More ILT Courses to a Single Student 

1. Navigate to User Management. 

2. Search for the student. 

3. In the resulting list, locate the desired student. 

4. In the ILT Courses column, click the View link. The Classroom Scheduler screen 
appears. 

5. In the Not Registered list box, select the courses for which the student is to be 
registered.   

6. Click the Update Registrations button to register the student for the selected 
course or courses.  

To Remove One or More ILT Courses from a Single Student 

1. Navigate to User Management. 

2. Search for the student. 

3. In the resulting list, locate the desired student. 

4. In the ILT Courses column, click the View link. The Classroom Scheduler screen 
appears. 

5. In the Registered list box, select the courses to drop.   

6. From the Drop Reason drop-down, select the reason the student is being dropped 
from the course. If the desired drop reason does not exist, refer to Maintaining 
Drop Reasons for instructions. If you are a Supervisor, please notify the 
Department Head to add the desired reason. 

7. Click the Update Registrations button to drop the student from the selected 
course or courses.  
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Assigning a User to an OLT Course 

To Assign One or More OLT Courses to a Single Student 

1. Navigate to User Management. 

2. Search for the student. 

3. In the resulting list, locate the desired student. 

4. In the OLT Courses column, click the View link. The Classroom Scheduler 
screen appears. 

5. To sort the available courses by course name, from the Group By drop-down, 
select Course Name, click the Go button. 

6. In the Available Courses list box, select the courses for which the Student is to 
be registered.   

7. Click the Add Course button to register the student for the selected course or 
courses.  

To Remove One or More OLT Courses from a Single Student 

1. Navigate to User Management. 

2. Search for the student. 

3. In the resulting list, locate the desired student. 

4. In the OLT Courses column, click the View link. The Classroom Scheduler 
screen appears. 

5. In the Registered Courses list box, select the courses to drop.   

6. From the Choose Drop Reason drop-down, select the reason the student is being 
dropped from the course. If the desired drop reason does not exist, refer to 
Maintaining Drop Reasons for instructions. If you are a Supervisor, please notify 
the Department Head to add the desired reason. 

7. Click the Remove Courses button to drop the student from the selected course or 
courses.  
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Assigning Multiple Users to an ILT Course 

The Department Head, the Instructors and the Supervisors can assign multiple students to 
an ILT course. Assigning multiple students to an ILT course simplifies the registration 
process for students. 

To Assign Multiple Students to an ILT Course 

1. Navigate to User Management. 

2. Under Options, click the Assign Multiple Users to an ILT Course link. 

3. In the Multiple Student Registration pane, from the Course drop-down, select the 
course. 
 

 
4. From the Class drop-down, select the class. 

5. To narrow the list of students, from the User Grouping drop-down, select a group. 

6. In the Not Registered list box, select the student(s) to register. 

7. Click the Update Students button. 

To Remove One or More Students from an ILT Course 

1. Navigate to User Management. 

2. Under Options, click the Assign Multiple Users to an ILT Course link. 

3. In the Multiple Student Registration pane, from the Course drop-down, select the 
course. 

4. From the Class drop-down, select the class. 

5. To narrow the list of students, from the User Grouping drop-down, select a group.  

6. In the Registered list box, select the student(s) to drop.   

7. From the Drop Reason drop-down, select the reason the student is being dropped 
from the course. If the desired drop reason does not exist, refer to Maintaining 
Drop Reasons for instructions. If you are a Supervisor, please notify the 
Department Head to add the desired reason. 

8. Click the Update Students button to drop the course. 
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Assigning Multiple Users to an OLT Course 

The Department Head, the Instructors and the Supervisors can assign multiple students to 
an OLT course. Assigning multiple students to an OLT course simplifies the registration 
process for students. 

To Assign Multiple Students to an OLT Course 

1. Navigate to User Management. 

2. Under Options, click the Assign Multiple Users to an OLT Course link. 

3. From the Course drop-down, select the course. 

4. Click the GO button. 

5. From the Class drop-down, select the class. 

6. Click the Select students for this course button. 

7. Search for the desired students. 

8. In the Select a student list box, select the desired students. 

9. Click the Add Student button. 

To Remove One or More Students from an OLT Course 

1. Navigate to User Management. 

2. Under Options, click the Assign Multiple Users to an OLT Course link. 

3. From the Course drop-down, select the course. 

4. Click the GO button. 

5. From the Class drop-down, select the class. 

6. Click the Select students for this course button. 

7. Search for the desired students. 

8. In the Select a student list box, select the student(s) to drop.   

9. From the Drop Reason drop-down, select the reason the student is being dropped 
from the course. If the desired drop reason does not exist, refer to Maintaining 
Drop Reasons for instructions. If you are a Supervisor, please notify the 
Department Head to add the desired reason. 

10. Click the Remove Student button. 
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TTEECCHHNNIICCAALL  TTIIPPSS  

Accessing DOI LEARN from Home 

The minimum modem speed for accessing DOI LEARN at home is a 28.8 Kbps. 
However, it is recommended that you use a 56 Kbps modem for faster access. With a 28 
Kbps modem, it will take about seven minutes for a course to download. Once the course 
download is complete, you can move quickly to each page since the course is in cache 
memory. 

Browser Setting Tips 

Be sure to use either Netscape Navigator 7.1 or Internet Explorer 5.0 (or higher) to avoid 
potential issues with the courseware. 

Make sure that both cookies and scripting are enabled. You will not be able to bookmark 
courses unless the cookies and scripting options are enabled. 

To Check Internet Explorer 6.0 for Cookies and Scripting 

1. Under the Tools menu, select Internet Options. 

2. Click the Privacy tab. 

3. Move the slider to Medium. If no slider exists, click the Default button. 

4. Click the Security tab. 

5. Click the Custom Level button. 

6. In the Reset to drop-down, select Medium. 

7. Click the Reset button. 

8. To confirm the change, click Yes. 

9. Click the OK button. 

To Check Internet Explorer 5.0-5.5 for Cookies and Scripting 

1. Under the Tools menu, select Internet Options. 

2. Click the Security tab. 

3. Click the Custom Level button. 

4. In the Reset to drop-down, select Medium. 
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5. Click the Reset button. 

6. To confirm the change, click Yes. 

7. Click the OK button. 

To Check Netscape 7.1 for Cookies and Scripting 

1. Under the Edit menu, select Preferences. 

2. Double-click Privacy & Security. 

3. Click Cookies. 

4. Make sure that Enable cookies based on privacy settings is selected. 

5. Click View. 

6. Make sure that Medium is selected. 

7. Click OK. 

8. Double-click Advanced in the Category box. 

9. Click Scripts & Plugins. 

10. Make sure Navigator is checked. 

11. Check all of the boxes under the Allow Scripts to: heading. 

Browser Settings for Java 

Some NETg courses require a Java Virtual Machine or Java Run time Environment. Be 
sure to check that they are available for NETg courses. 

When you start a NETg course, a new browser window opens and NETg's Java applet 
will download. This will take approximately 1-2 minutes depending on your Internet 
connection and computer. Once this initial load is complete, the course pages forward 
quickly. The NETg course will be displayed within this new window. 

To Check Internet Explorer for Java 

1. Under the Tools menu, select Internet Options. 

2. Click the Advanced tab. 

3. Locate the Browsing heading. 

4. Check the two Disable Script Debugging options. 

5. The computer must have either Microsoft NM or Java (Sun); the courses will not 
work if both are enabled. 
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6. If you locate Microsoft VM. 

a. Check the three check boxes under Microsoft VM. 

b. If Java (Sun) is directly above Microsoft VM, uncheck the Java 2 V1.4x 
checkbox. 

7. If you have Java (Sun) and cannot locate Microsoft VM. 

a. Check the check box for Java 2 V1.4x. 

8. Click the OK button. 

Note: The courses will not work if you have both Java (Sun) and 
Microsoft VM enabled. Make sure only one of them is enabled. 

To Check Netscape 7.1 for Java 

1. Under the Edit menu, select Preferences. 

2. Click Advanced. 

3. If Enable Java is not checked, check this option now. If you do not enable Java, a 
blank screen will appear in Web Player 2.0 courses and you will not be able to 
continue in the course. 

4. Click the OK button. 

Browser Settings to Keep Cache Cleared 

If the system is very slow or locks when trying to launch an application or course, you 
may need to clear your content cache. 

To Clear the Cache Using Internet Explorer 6 

1. Under the Tools menu, select Internet Options. 

2. Under the Temporary Internet files section, click the Settings button. 

3. Select the Every visit to the page option. 

4. Click the OK button. 

5. Under the Temporary Internet files section, click the Delete Files button. 

6. Click the OK button. 

7. Click the Refresh button on your browser. 
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To Clear the Cache Using Netscape 7.1 

1. Under the Edit menu, select Preferences. 

2. Double-click Navigator. 

3. Click History. 

4. Click Clear History. 

5. Double-click Advanced. 

6. Click Cache. 

7. Click Clear Cache. 

8. Click OK. 

Disabling Pop-up Blockers in Internet Explorer 

If the course comes up with a blank white window, you may have a popup blocker that is 
stopping the course from loading.   

1. Right-click on the File menu. 

2. Uncheck everything except Standard Buttons, Address Bar, Links, and Lock 
the Toolbars. 

3. If you try to load the course again and still are getting a blank white window close 
the blank window. This time try holding down the CTRL key while you click on 
the course to see if it loads. 

Internet Speed Tips 

If you are trying to access a course or are in a course and it locks, it is most likely an 
Internet speed connection issue. It could also be a problem with your computer. You can 
test the practical throughput of your connection by doing the following: 

1. Use this bandwidth test tool by entering your connection information and clicking 
the Go button. 

2. If the speed is below 15 Kbps, there will probably be problems with the course 
locking or the course not launching. Please check with your Internet Service 
Provider (ISP) to see if the speed can be increased. 

 

You can check the version of the Java Run time Environment, and increase your 
connection speed, by doing the following: 
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For Windows 95, 98, or Me 

1. Open a DOS prompt by clicking the Start button in the lower-left hand corner of 
the screen. 

2. Click Run. 

3. In the Open field, type command. 

4. Click the OK button. A DOS window will appear. 

For Windows NT, Windows 2000, Windows XP or Windows 2003 

1. Open a command-line session by clicking the Start button in the lower-left hand 
corner of your screen. 

2. Click Run. 

3. In the Open field, type cmd. 

4. Click the OK button. This will bring up a command-line session. 

5. Type java-version at the prompt and press Enter. 

6. Verify that the Java Version is at least 1.02 or higher. 

7. If your Java version does not met this standard, visit the Plug-Ins Installation 
Center. From there you will be able to download and install the latest version of 
the Java Run time Environment (JRE). 

 

Note: Please contact your organization's IT Help Desk support group if 
you have any questions about installing the Java client on your 
workstation. 

Managing Browser Cookies 

Cookies are small text files that are stored on your PC by your browser. They can contain 
information such as your name or your list of completed sections. 

You should delete cookies if: 

• the cookie is corrupted, 

• the information saved is not correct (e.g., sections are marked as completed but 
they are not, etc.), or 

• you cannot launch a course. 

If you use the Internet often, empty your temporary Internet files weekly (i.e. clean your 
cache) to prevent cookies from being corrupted. These cookies are cached only while you 
are visiting the site and are deleted from the cache when you close the session. 
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For Internet Explorer 5.0 – 5.5 

1. Under the Tools menu, select Internet Options. 

2. Under the Temporary Internet files section, click the Delete Cookies button. 

3. To confirm deletion, click the OK button. 

For Internet Explorer 6.0 

1. Under the Tools menu, select Internet Options. 

2. Under the Temporary Internet files section, click the Delete Cookies button. 

3. Click the OK button. 

4. Click Delete Files. 

5. Select Delete all offline content. 

6. Click the OK button. 

7. Click the OK button. 

To Delete Cookies in Netscape 7.1 

1. From the Edit menu, select Preferences. 

2. Double-click Privacy & Security. 

3. Click Cookies. 

4. Click Manage Stored Cookies. 

5. Click Remove All Cookies. 

6. Click Close. 

7. Click OK. 

Navigation Tips 

Use Text Links 

Use the underlined text links to access the features named within each. 

Use Quick Links 

Use the bar on the top right portion of the page to quickly log on, log off, go to the My 
Courses or Catalog pages. 
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Use the Menu Bar 

DOI LEARN modules each have an associated menu bar. Depending on the features you 
are using, there may be additional menu bars and tabbed areas under the top-level menu. 
Click the underlined link in a menu bar to access that feature. The feature you choose 
may have multiple pages associated with it. To return to the main (beginning) page of a 
feature, click the tab or underlined link in the menu bar. 

Exit DOI LEARN 

To exit DOI LEARN, click the Log Off link in the Quick Links menu bar. 

System Performance Suggestions 

In order to optimize your computer, clear the temporary files once a month along with 
these other maintenance items. 

• Delete temp files from your Windows directory. 

• Delete temp files from Netscape and Internet Explorer. 

• Empty your recycle bin. 

• Run Scan Disk or similar tool to scan your hard drive and correct any errors. 
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GGLLOOSSSSAARRYY  

A 
AICC: Aviation Industry CBT Committee 

B 
Book Bag: In the optional Product Library, a holding area (similar to the shopping carts 

used on sites that sell merchandise) where items a student wants to check out are 
placed until the student decides to check out the items or remove them. A 
librarian must approve whether an item can be checked out before the student can 
pick it up or have it sent to him or her. 

C 
Category-Learning Center: In DOI LEARN, courses and classes can be associated with 

categories so students can search for all courses under a particular category. 

Category-Product Library: Anyone with a department-head logon can maintain 
administrative information (such as adding users, creating courses, and registering 
students for courses) for DOI LEARN. 

D 
Department Head: Anyone with a department-head logon can maintain administrative 

information (such as adding users, creating courses, and registering students for 
courses) for DOI LEARN. 

H 
Home Library: Since a corporate library can have multiple locations (libraries), students 

need to specify which library they wish to use which is the student's home library. 

I 
ILT: Instructor-led training 

Instructor: Instructor-level logons give the instructor access to their courses and 
students. Courses can be created, tracked, updated, etc. For Instructor-Led 
courses, the Instructor may also update attendance and make notes on a class or 
student. 
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L 
Learning Management System (LMS): Software that automates the administration of 

training events. All LMSs manage the log-ins of registered users, manage course 
catalogs, record data from learners and provide reports to management. 

Learning Plan: A list of courses and tasks that an instructor or administrator assigns to 
help students reach a learning objective. 

Librarian: A person who has permission to maintain an assigned corporate library. 

Library Access Code (LAC): Also referred to as Open Restricted Registration. Students 
may open enroll for any course they desire provided their LAC matches the LAC 
for that course. This provides a level of control over the courses. Certain groups 
of employees may freely enroll. 

M 
Master Librarian: A person who has permission to maintain all corporate libraries as 

well as designate librarians. 

Media Type: The format, such as a book, VHS, audio tape, or CD-ROM, of an item in 
the library. For example, the library might contain a version of a training module 
in book form, as an audio tape, and on CD-ROM. The media type associated with 
a product allows students to choose the most convenient medium when selecting 
products to check out of the library. It also helps librarians to track the types of 
materials available in the library. The list of available media types can be added to 
and changed by master librarians. A media type can also be deactivated, and then 
reactivated, by a master librarian. 

O 
OLT: Online Training 

P 
Product Code: A unique identifier for an item in a library. If you have multiple copies of 

the title, each copy will have a separate product code. We recommend you use the 
last five digits of the ISBN code, followed by a letter of the alphabet to indicate 
whether this is the first copy, second copy, and so on. For example: 26428A for 
the first copy, 26428B for the second copy, and so on. 

Product Library: The optional Product Library is a Web-enabled library database. It is 
an optional module of your Learning Management System (LMS). This tool is a 
virtual catalog system that automates the set-up and management of your 
corporate library. Administrators and corporate librarians set up and monitor the 
use and location of online courses, CD-ROMS, video, audiotapes, book, and 
print-based materials, as well as files that students can download from any 
number of geographically dispersed locations. 
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Publisher: The entity responsible for an item's production and distribution. To locate the 
publisher name, check the title page of a book, or the back cover of the item. 

S 
SCORM: Sharable Content Object Reference Model 

SF-182: The SF-182 Form (Request, Authorization, Agreement, and Certification of 
Training) is used to document the authorization and approval of training. It serves 
as supporting documentation for obligating and paying for training courses and 
provides a record for the employee. 

Site Administrator: The GeoLearning administrator who can maintain information for 
your learning center. A site administrator logon allows for the highest level of 
system permissions. 

Student: Students can take courses and tests, complete surveys, rate courses, and view 
any of their own information. If your company has an open registration policy, 
students can register for courses offered through DOI LEARN. 

Supervisor: Supervisors can access information about other students who have been 
designated as being on their team. 

U 
User-defined task: Instructors can define tasks that describe an action students need to 

perform which are called user-defined tasks. The student must tell the instructor 
when the task is complete, and the instructor will modify the student's records to 
show the task as completed. 

 


